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Government Reporting Tool

Use the Government Reporting Tool (GRT) to extract primary health care key performance
indicators (nKPIs) for indigenous people from Communicare, analyse the data and directly upload
the data to the Health Data Portal.

Since January 2019, the Government Reporting Tool (GRT) has been used to extract data for the
nKPI, OSR and Health Care Provider (HCP) submissions from Communicare. This tool should be
used by health service management personnel who are responsible for periodically collating,
analysing and reporting on nKPI data. The GRT uploads the extracted data to the Commonwealth
Department of Health (DoH) Health Data Portal.

e Tip:

For more information about Indigenous Health Data Reporting, see IHDR User Help.

Before each submission period, Communicare Support will contact local Communicare
Administrators to ensure that the GRT is accessible and any updates to the GRT and reports are

communicated.

Data can also be reviewed at any time using the following Communicare report suites:

* Report > nKPI
* Report > OSR

* Report > Health Care Providers

Communicare Administrators should run these reports regularly to check that their health service’

s data is on track before the January and July submission deadlines.

o ™
Note:
For state-based reporting, NT KPI (on page 127) and NSW KPI (on page 122) reporting
suites are available in Communicare as both individual reports and aggregated
summaries. Refer to your state health departments for the correct process to submit your

data.
o J

Government Reporting Tool prerequisites

Before you run the Government Reporting Tool and upload Indigenous Health Data from

Communicare to the Health Data Portal, ensure that each of the following steps are completed:


https://dataportal.health.gov.au/
https://dataportal.health.gov.au/
https://dataportal.health.gov.au/wps/portal/dataportalcontent/usersupport/userhelpihdr/!ut/p/a1/nZBdb4IwFIb_ym68bHqAgnBJdImIxJGZKL0xpRTpAqVCXeZ-_UpMFm_22bs3PXnPcx5M8QFTxV7liRnZK9ZOmQZHP0kTIOCmkC0JxJHv55GfQJjO8R5TTLky2jS4qJhhuh8Max94r4xQZgbjdTSim8FlFMN40dP3LTSi1bKphqlAc1nhArygEg44KKoZR0SEDmLgCVQGpORhWTJehpaosETwxYvhV8DfNxR2xfzobBewWhPYbHfEhxxy93G5cgBcwM9_ZF7_BGWPcodskZ1sLTMNkqru8eFO2S18KrPz8uV8prF1P4l-swP_k6-7LvSuSL3v6m7_tIk_AE0RQGE!/dl5/d5/L2dBISEvZ0FBIS9nQSEh/
https://bit.ly/communicarehelp

1. Obtain the AIHW security data token from the Department of Health.

2. Communicare Support has enabled the data token for your site.

3. Communicare Support has set up and configured SQL Server Express for your organisation.
4. Communicare Support has installed the Government Reporting Tool on your organisation’s

Communicare server and ensured that it is working correctly.

Government Reporting Tool overview

To ensure that your site is ready for the reporting submission period, complete the following

steps:

1. Ensure Communicare is configured in accordance with the NPKI information (on page 20)
and that staff are using the correct items.

2. Use the Communicare reports to audit biographics for missing data and ensure staff are
using the correct place and mode to record consults.

3. Run the nKPI reports (on page 63), OSR and Health Care provider reports (on page 104)
reports in Communicare to verify the state of the data and repeat steps 1-2 if required. For
a list of the available government report suites in Communicare, see Statutory Reporting
and Communicare (on page 8).

4. Ensure the Government Reporting Tool is installed and accessible by the Communicare

Administrator or person responsible for uploading to the Health Data Portal.

When these steps are complete, you can run the Government Reporting Tool to submit your data

to the DoH Health Data Portal.

Statutory Reporting and Communicare

There are currently four major reporting suites in Communicare for government reporting. Other
program reporting suites may exist on your database, such as PMHC, CHSP, ITC, HACC, ANFPP,
APCC.

Reporting suites

Reports usually have the following parameters:

8 GRT & nKPI Reference Guide



« A date range or report date where the end date is usually 30th June or 31st December. For
internal reporting this can be any date required. Where a ‘from date’ is collected it may be
ignored for some indicators where the currency period is defined in the indicator.

* A locality group parameter with the option <All Locality Groups>. In most cases this last
option should be selected but where more than one organisation shares a database, or
internal reporting for separate regions is required, a specific locality group may be selected.

« A patient indicator that can be Al HW Regul ar d i ent Or Communi care Current Patient. OSR,

nKPI and NSW reports must be uploaded with the Al HW Regul ar d i ent option selected.

The four reporting suites below essentially perform similar tasks for different agencies but differ

in various ways. This table is to help you understand the differences.



Table 1. Comparison of KPI reporting suites

non-Administra
tor

Reporting OSR National KPI NT AHKI NSW KPI
Included in Yes Yes Yes Yes
Communicare

CS-01to PI01 to AHKPI KPI 01 to KPI
CS-04 PI125 1-01to 09
HP-01 AHKPI
L-06 to Additional: 1-20
L-07
MCH-01 Pati ent |Additional:
to Li st -
MCH-03 identified Set up
S-06 to patients - report
S-07, defined as to assist
S-10 to regular configur
S11 & Ver si on ing
S-13 to - encounter
S-14 specifies places
SE-06 to the and
SE-07 version locality
HCP of the groups
reports
Additional:
Epi so
des and
Cont a
cts by
Clinic
- may be
required
for
separate
reporting
for
remote
clinics
Canberunbya |Yes Yes Yes Yes

10
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Table 1. Comparison of KPI reporting suites (continued)

functionality

Government
Reporting Tool
- Includes only
CS-01 to CS-03
(renamed as
AP1 to AP3) and
HP-01 (renamed
as CSP2)

Government
Reporting Tool -
all indicators

manually
uploaded to

NT portal - run
AHKPI Dat a
Export and
save output as a
CSV file

Reporting OSR National KPI NT AHKI NSW KPI
Can report on No Yes Yes Yes
patient names
Each report has | Each report Each report has the
a companion shows patient option to include
report that names patient names or not
displays patient
names
Single report No Yes Yes Yes
available
Sunmmary AHKPI Dat a
- reports Dat a Summary
on any Export
indicator AHKPI
where Dat a
there is Export
some data for
Sel ec
ted
Cinic
AHKPI
Dat a
Export
Summary
Upload Communicare’s | Communicare’s | Data Export Manual data entry

-Data Summary
to be printed and
transcribed into NSW
portal

Run the Government Reporting Tool

At reporting time, use the Government Reporting Tool (GRT) to extract the nKPI data you need

from Communicare and submit it to the Department of Health Data Portal.

11



Before you begin
First, ensure you have the latest version of the GRT and its associated data by running the

Communicare Data Updater. For more information, see Update the GRT (on page ).

About this task

Australian Government

Preview KPls in directony Submit previewed KPls from Department of Health

g O

]
=1
1

[T
1
el
i
[=]
=]
[=]
E (]
C o

m
= =
o

The overall process for extracting Indigenous Health Data from Communicare and uploading the

data into the Health Data Portal can be distilled into the following steps:

1. Using the Government Reporting Tool, extract data from Communicare to spreadsheets

which you can review.
2. Using the Government Reporting Tool, upload the KPI data to the Health Data Portal.

3. In the Health Data Portal, review and confirm the submission.

Procedure
To run the Government Reporting Tool on or after 1 July of each year:

1. In the Microsoft Windows Explorer, go to \ \ Comruni care servername\ |l nstal |
\ GRT, where ser ver nane is the hostname assigned to your Communicare server by your

Administrator or IT.

2. Double-click GovernmentReportingTool to run it.

12 GRT & nKPI Reference Guide


unique_12
unique_12
unique_12

& Government Reporting Tool 1.5.2 (1.2.1.0) HEALT... — O =
Report end date: 31/03/2021 ml
Organisation: All organisations =
Group: All groups =
Refresh data MNote that this will take a long time
Praview KPlg in directory A . \Documents
using secunty token VLIt dljdk
Show administrator information

The title bar of the Government Reporting Tool displays the version of the tool, the
username of the person who is logged on and the name of the computer. Check with

Communicare Support that you are running the latest version.

3. In the Government Reporting Tool window:
a. From the Report end date calendar, set the reporting date to the end of the reporting
period. No data recorded after this date is included in the nKPlIs.
b. From the Organisation list, select the organisation for which the KPI extract will be

generated or set to All O gani sati ons.

Note:

Often the Health Data Portal only accepts submissions for which Al |

O gani sat i ons has been selected.

c. From the Group list, select a locality group. This determines which patients are

included in the KPI extract.

4. If you have updated the Communicare nKPI configuration as described in NPKI information
(on page 20), click Refresh data. The tool retrieves data that is new or has been updated

in Communicare since it was last run. The refresh process takes 5 - 60 minutes.

0 Tip:

Data is automatically refreshed nightly. Click Show administrator information to

see when the data was last refreshed.

13
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You can also click this link in the following circumstances:
> You are directed to by the tool because it has detected an issue
> You have retrospectively updated historical encounters and want these historical

updates included in the nKPI reports

5. When the data is refreshed, click Preview KPIs in directory. This process takes 1-5 minutes.

The directory to which the files have been saved is opened when the process is complete.

6. If required, manually review the CSV output files using Microsoft Excel.

4 N
0 Tip:
To display the files in a format where you can filter and sort the data:
a. In Microsoft Excel, press CTRL+A to select all data.
b. Select Insert > Table.
- J

7. After you have reviewed the KPls, to submit the KPIs to the Health Data Portal in draft form

click Submit previewed KPIs from. This process takes 1-5 minutes.

Note:

This link is enabled only if the KPIs have been generated using an Organisation

and Locality Group that has an AIHW security token for your site.

Results

The Indigenous Health Data extracted from Communicare is uploaded to the Health Data Portal.

What to do next
Log onto the Commonwealth Department of Health (DoH) Health Data Portal and review the
draft submission and complete the data asset upload process. When you are satisfied with the

submission, change its status.

If you encounter problems using the Government Reporting Tool:

14 GRT & nKPI Reference Guide


https://dataportal.health.gov.au/

1. Click Show administrator information.

2. Copy or take a screen capture of all the content in the Show administrator information pane

and attach it to a ticket for Communicare Support for resolution.

0 Tip:

Scroll down to view all data.

GRT output files

The Government Reporting Tool produces the following files.

MName Date modified Type Size
system 06/2019 4:38 PI File folde
E Hepltems.csv 06/2019 4:32 PM Microsoft Excel Co & KE
E{l'] NkpiCountMeasures.csv 06/2019 4:32 P\ Microsoft Excel Co KB
E,'T': MNkpiPercentageMeasurePatients.csv  6/06/2019 4:39 P! Microsoft Excel Co 2,332 KB
£3° NkpiPercentageMeasures.csv 6/06/2019 4:38 PM  Microsoft Excel Ce 4 KB
ﬁ OsrCountMeasures.csv 0 4:38 PI Microsoft Excel Co.. 3KB
Table 2. Files produced by the GRT
File Purpose

Hcpltens. csv

A list of providers

Nkpi Count Measur es. csv

A count of the total number of clients included for each KPI

Nkpi Per cent ageMeasur ePa
tients.csv

The numerator, denominator and percentage for each KPI,
that is the underlying data. This is equivalent to the nKPI
Patients Report in Communicare.

Gsr Count Measur es. csv

Counts for operational services

O g. xm

system Manual - HCP - This file is used if it’s necessary to manually upload the HCPs

O g. xm to the Health Data Portal using the Department of Health
website.

system Manual - NKPI - |Thisfile is used if it's necessary to manually upload the nKPlIs

O g. xm to the Health Data Portal using the Department of Health
website.

system Manual - OSR - This file is used if it’s necessary to manually upload the OSRs

to the Health Data Portal using the Department of Health
website.

15
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Troubleshoot the GRT

If you have a problem running the Government Reporting Tool, check here before contacting

Communicare Support

Check the following:

1. Your domain user account or group has been given access to the GRT.

2. The GRT is being passed through the correct hostname to the SQL Server that it uses.

3. There are no security policies blocking access to TCP and UDP ports 1434 and 1433 on the
SQL Server.

4. There are no group policies preventing the GRT being run. Check with your Network System
Administrator.

5. You have access to the shared folder where the GRT is installed.

6. The SQL Server is running.

If you are still experiencing difficulties contact Communicare Support.

Manually upload nKPI files to the Health Data Portal

Running the Government Reporting Tool automatically uploads all of the necessary data to the
Health Data Portal.

Before you begin
However, if you encounter connection errors, you can upload the xml files created by the tool to

the Health Data Portal manually.

About this task
e I

Note:
This information is a general guide only. For further support and help, see Indigenous
Health Data Reporting (IDHR) or call 1800 316 387 (8.30am to 5pm AEST Monday to

Friday, excluding ACT and national public holidays).
- /

Procedure
If the automatic upload to the Health Data Portal fails, to upload the files generated by the

Government Reporting Tool manually:

16 GRT & nKPI Reference Guide


http://bit.ly/communicarehelp
https://dataportal.health.gov.au/wps/portal/dataportalcontent/usersupport/userhelpihdr/!ut/p/a1/nZBdb4IwFIb_ym68bHqAgnBJdImIxJGZKL0xpRTpAqVCXeZ-_UpMFm_22bs3PXnPcx5M8QFTxV7liRnZK9ZOmQZHP0kTIOCmkC0JxJHv55GfQJjO8R5TTLky2jS4qJhhuh8Max94r4xQZgbjdTSim8FlFMN40dP3LTSi1bKphqlAc1nhArygEg44KKoZR0SEDmLgCVQGpORhWTJehpaosETwxYvhV8DfNxR2xfzobBewWhPYbHfEhxxy93G5cgBcwM9_ZF7_BGWPcodskZ1sLTMNkqru8eFO2S18KrPz8uV8prF1P4l-swP_k6-7LvSuSL3v6m7_tIk_AE0RQGE!/dl5/d5/L2dBISEvZ0FBIS9nQSEh/
https://dataportal.health.gov.au/wps/portal/dataportalcontent/usersupport/userhelpihdr/!ut/p/a1/nZBdb4IwFIb_ym68bHqAgnBJdImIxJGZKL0xpRTpAqVCXeZ-_UpMFm_22bs3PXnPcx5M8QFTxV7liRnZK9ZOmQZHP0kTIOCmkC0JxJHv55GfQJjO8R5TTLky2jS4qJhhuh8Max94r4xQZgbjdTSim8FlFMN40dP3LTSi1bKphqlAc1nhArygEg44KKoZR0SEDmLgCVQGpORhWTJehpaosETwxYvhV8DfNxR2xfzobBewWhPYbHfEhxxy93G5cgBcwM9_ZF7_BGWPcodskZ1sLTMNkqru8eFO2S18KrPz8uV8prF1P4l-swP_k6-7LvSuSL3v6m7_tIk_AE0RQGE!/dl5/d5/L2dBISEvZ0FBIS9nQSEh/

1. Copy the XML files created by the Government Reporting Tool to your computer. For more
information, see GRT output files (on page 15).
2. Log into the Health Data Portal.

3. Select New > Asset for Submission.

m.;‘&i“ DATA [PORTAL

Isepartmsnt of Health

Search ¥

2 Assets Tor Indigenous Health > nPl

™ Indhgencus Health Status & Data Pericd 2 Tithe &
w Dendt Swbmission 20T 2018 to FDec2018 Communicare Test Manual Fie i
Submission Approved 19T 2018 to 19 Dec2018 Communicare Tes! Submission
Deadt Swbmission 1M 2018 to Mo 18 fast

4. In the New Draft Submission window, add information to all required fields:

= 'DATA |PORTAL

Departmsent of eaith

n = New = Manage 9

‘ New Draft Submission

pssetDetals  smomaysus =

Tithe * CC TestFide

Description o

497 charachers remasning

Submitied by
Organisation
Date Submitted
Folder® Folder® Indiganous Health I=d
(This determines who in Health
receives the submission) Sub-Folder AKP w
Addmional info
Reporting Round Reporing Period Trial Submission R
Duata Period Trial Submission
Data Period Stat  0UDeZ018 End  11Lan20139
Files
Filet Haime Last Modified Description Actions

Ho Bles hive Deen 20060 yel

Cancel A Add File B Create nKPI Farm
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a. In the Title field, add a title.

b. From the Folder list, select the required folder. For example, | ndi genous Heal t h.
c. In the Data Period fields, enter the reporting period.

d. If required, click Create nKPI Form.

e. Click Add File and upload the xml file from your computer.

f. Click Save.
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Key Performance Indicators

Health service management personnel can collate, analyse and report on National Key

Performance Indicators and state-based Key Performance Indicators using Communicare.

- ™
Note:
You can make National Key Performance Indicator (nKPI), Online Services Reports (OSR)
and Health Care Provider (HCP) submissions from Communicare, using the Government

Reporting Tool (on page 7).

Data can also be reviewed at any time using the following Communicare report suites:

* Report > nKPI
* Report > OSR

* Report > Health Care Providers
For state-based reports:

* In New South Wales, run the reports in Report > NSW KPI.
« In the Northern Territory, run the reports in Report > NT KPI. For more information, see NT
AHKPIs (on page 127).

Data requirements

To use Communicare for reporting on Key Performance Indicators, the following data requirements

must be met:

» Conditions are coded using the central ICPC2-Plus dataset

* Prescriptions are recorded using the prescribing module which relies on the MIMS
Pharmaceutical database

« Medicare claims are bulk-billed and use the Communicare electronic claims module

» Pathology results are delivered electronically using HL7 results with appropriate coding
returned by the lab

* Common qualifiers that may be recorded as point of care testing or transcribed results,
for example, from a hospital discharge document, use the central qualifiers. If your health
service departs from the central dataset (for example, to record an ACR or GFR) it is your

responsibility to transcribe the associated system code or export code if the concept
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remains the same. For reference qualifiers, such as smoking status, attention must be made
to each reference’s system and export code.

« For state-based reporting, the health service is already configured for National KPI
reporting and needs only to consider state indicators that have no nKPI equivalent.
Wherever possible, given the definitions, data collection requirements are common across

the KPI reports.

National Key Performance Indicators

Use this information to assist with the Indigenous primary health care key performance indicators

(nKPI) and Online Services Report (OSR) reporting within Communicare.

This document outlines the way in which information recorded in Communicare is identified for

each indicator to enable health services to advise users on how best to ensure the most accurate
recording of data for the National Key Performance indicators (nKPI) and Online Services Report

(OSR) reports.

Demographics overview

Only those patients who meet the required Indigenous status, record status, patient status, age, or

address are included in the reporting for supported encounter modes and contact types.

Indigenous status

National Key Performance Indicator reporting almost exclusively reports on patients who are
recorded as being Indigenous. In Communicare this means that they have an Indigenous Status

recorded in their biographics of one of the following:

® Aboriginal but not Torres Strait |slander
®* Torres Strait Islander but not Aboriginal

® Both Aboriginal and Torres Strait |slander

Any exceptions are stated in the definition for that specific indicator.

OSR reporting is disaggregated by Indigenous Status. In these reports the following mapping is

done:
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e Aboriginal & Torres Strait |slander -includes all patients with one of the
above statuses recorded in their biographics.

* Non- Abor i gi nal - any patient with an Indigenous Status of Nei t her Abori gi nal nor
Torres Strait

* Not Recorded - any patient where the Indigenous Status is not recorded, or the Indigenous

Status is Not stat ed/inadequately descri bed Or Not appl i cabl e.

( ot

Note:
For OSR reporting, fictitious patients are excluded. Patients who died before the end of
the reporting period are counted if they had any activity during the report period. Non-
patient records are included to record group activity and contacts made with patients
who do not normally attend this health service. For the purposes of disaggregation by

Indigenous Status, all non-patients are recorded as Not Recor ded.

N

Record status

For the AIHW definition of a Regular Client this status is determined by looking at the contacts
made with a patient in the two years preceding the end of the report period. In Communicare, a

patient's status must be one of the following:

® Current

* Transi ent

* Past

® Banned 30 days

® Banned 60 days

Patients who have a Communicare patient status of Fi cti t i ous (either at the time the report
is run or at the end of the report period) are excluded. Patients who had a Communicare patient

status of Non- Pat i ent at the end of the report period are also excluded.

Only services that have started are included: services with a status of St art ed, Paused or

Fi ni shed are included. Services with the following statuses are excluded:

» Booked

e Cancel | ed
« Wi ting

« Wt hdr awn
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Additionally, services with the following modes are excluded:

« Allno client contact modes

e« Adm ni stration — client contact

If a patient has at least three such services in the two years preceding the end of the report
period and they were still alive at the end of the report period, then they are deemed to be a
regular client. However, see the comments in the Residence section below relating to the patient’
s home address at the end of the report period and how this relates to use of the Locality Group

parameter in Communicare reports.

OSR reporting does not use the Regular Client status. All patient records are included except
Fictitious patient records. Non-patient records are included but reported with an Indigenous
Status of Not Recor ded.

Patient status

For nKPI reporting, all patients with a status of Non- Pat i ent are excluded even if they have

three visits in the previous two years.

For OSR reporting, the Non- Pat i ent status is treated in the following way:

« If the patient record has an MRN of #GROUP, group activity will be counted but not in the
contacts, episodes or individuals reports.

« If the patient record has an MRN of #ANQON, any activity is disregarded. This means that
the patient record is for anonymous activity and any age, sex or Indigenous status will be
unknown so the data cannot be disaggregated.

« If the patient record does not have an MRN of either #ANON or #GROUP, activity will also
be disregarded.

To assist in the identification of any existing Non-Patient records where the addition of either
#ANON or #GROUP is needed, refer to the report at Report > OSR > Non-Patient Analysis.This
report should eventually report three main sections (if anonymous or group activity is recorded at

the health service):

» Group activity record: an example is UNIDENTIFIED CLIENTS. If the patient ID has an
asterisk, this is currently being used for group activity.

* Anonymous patient record: examples might be NEEDLE EXCHANGE, MALE or WALKIN,
UNKNOWN.
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» Other non-patient records: these should all be real people but who only attend the health
service for specific purposes other than their main health care, such as, dental only patients
or ITC patients referred from a private GP for supplementary services. If they should be
included in the nKPI reports and the OSR reports, their status must be changed from non-

patient.

-
0 Tip:

Only use the Non- Pat i ent status for the following reasons:

« To record biographic details of a carer who is responsible for a patient of the
health service but who does not attend for their own health care

 To record a real patient who may attend the health service for a single purpose,
such as a dental clinic, but who belongs to another health service and does not
require any other health service delivery, such as health check reminders, blood
tests, chronic disease management, and so on.

 To record anonymous services such as group information sessions, anonymous

needle exchange, health promotion events, and so on.

o j

Residence

A patient must have had a home address at the end of the report period. What this means is that a
patient added after the end of the report period will not be included even if they have backdated

service activity.

When the Locality Group filter is used for any of the Communicare reports the patient list is
filtered to those patients whose home address locality at the end of the report period was within
the defined list of localities that make up that locality group. It is important that the locality
groups defined at the health service are accurate and inclusive. To help you review your locality

groups run the following reports:

« To print a list of all localities within all locality groups, run Report > Reference Tables >
Locality Groups. Maintenance to these lists is done at File > Reference Tables > Locality
Groups.

* To look for omissions and mistakes, run Report > Reference Tables > Locality Group

Analysis.
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e M
O
Run this report with a range of post codes that covers your health service area
completely.
Firsl post code o inchuds I[@m
Laat post code o nclude Iug;g
State [wT =
rehUnsed Locsier [ -
- /

The resulting report will show all locality groups and indicate which localities belong to
multiple or no such groups. Maintenance to these lists is done at File > Reference Tables >
Locality Groups.

Age groups

The default nKPI age groups are:

* 0-4 years

* 5-14 years
* 15-24 years
» 25-34 years
* 35-44 years
* 45-54 years
* 55-64 years

* 65+ years

Where stated in a specific indicator these may vary. For example, child immunisation age groups

differ as do antenatal care age groups.

Age is calculated at the end of the report period (unless a specific indicator states otherwise).
Patients who died during the preceding two years but who have had three valid services recorded

will be excluded.

Contact types

OSR reporting requires disaggregation of provider types when reporting on contacts. In
Communicare, a provider type is in recorded in Communicare in the Provider reference table: in

File > Providers, select the provider type from the Speciality list.
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Sumame: |E Eon
Duskiication: [mE
Specialty Gonerl Medical Froctione: [
Cntembes o Esxsscize Physiologet [~ ]
E e Health Condinabor
Jﬂ (Gastroenbe ohogist
Medica
Genstician
Gynaecologeal (ncologst

Heakh Diagnosie/Testment Practiones |

For information about how the Communicare speciality is mapped to the OSR contacts report, see

Client Contact Types reference (on page 49)

Note:

Services provided exclusively by a Transport Worker (as recorded in Communicare in the

Provider reference table) are excluded from the OSR Episodes of Health Care report.

Encounter modes

Services recorded for most encounter modes where there is patient contact are included in nKPI

and OSR reports.

Table 3. Encounter modes

Automated
Consultation L. Included atient
Encounter Mode . Description . P
Delivery in reports status
updates?
Aboriginal Health In person Use to record a clinical nKPI and Yes
Service consultation where the OSR
patient attended the clinic.
Administration - Administrative | Use to record that although | None Yes
client contact - in person the health service has seen
the patient it was not for a
clinical reason.
Administration - no | None Use to record None No
client contact administrative work for a
patient.
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Table 3. Encounter modes (continued)

Automated
Encounter Mode Consu.ltation Description .Included patient
Delivery in reports status
updates?
Client's Home In person Use to record where nKPI and Yes
workers from the health OSR
service deliver services
at the client's home. Use
instead of creating a
separate encounter place
for each client.
Clinic - Consult In person Use to record a clinical nKPI and Yes
consultation where the OSR
patient attended the clinic.
Clinical Administrative | Client contact that is more | nKPI and Yes
administration - - in person clinically focused than OSR
client contact Adm nistration - —
client contact. No
te:
Incl
us
ion
in
repo
rts
may
be
affe
cted
by
prov
ider
ty
pe.
-
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Table 3. Encounter modes (continued)

Encounter Mode

Consultation
Delivery

Description

Included
in reports

Automated
patient
status
updates?

Clinical
administration - no
client contact

None

Clinical administration, for
example:

e Updating clinical
history - allergies,
past medical,
surgical. Gynae
history, family and
social history
Referrals - child
health, dietitian,
allied health,
social work, GP, OT,
exercise physiologist,
pharmacist
Applications - My
Aged Care, MASS,
Centrelink, Lions
Club equipment
Immunisations —
history, data entry,
documentation
verification
Pathology - follow
up and organising
treatment
* Notifications -
schools, GP, hospital,
discharge planners
e Discharge planning

None

No

Commercial setting
(e.g. pharmacy)

In person

Use to record where
workers from the health
service deliver services
at a business such as a
pharmacy. Use instead
of creating a separate
encounter place for each
business.

nKPI and
OSR

Yes
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Table 3. Encounter modes (continued)

Encounter Mode

Consultation
Delivery

Description

Included
in reports

Automated
patient
status
updates?

Community Health
Centre

In person

Use at community health
centres to record a clinical
consultation where the
patient attended the health
service.

nKPI and
OSR

Yes

Community Services
Centre

In person

Use to record where
workers from the health
service deliver services at a

Community Services Centre.

Use instead of creating a
separate encounter place
for each centre.

nKPI and
OSR

Yes

Contact Attempt
Unsuccessful - no
client contact

None

Use to record attempted
contact.

None

No

Court

In person

Use to record where
workers from the health
service deliver services
at court. Use instead

of creating a separate
encounter place for each
court.

nKPI and
OSR

Yes

Day Aged Care
Centre

In person

Use to record where
workers from the health
service deliver services
at a day aged care centre.
Use instead of creating a
separate encounter place
for each centre.

nKPI and
OSR

Yes

Day Procedure
Centre
(Free-standing)

In person

Use at day procedure
centres to record a clinical
consultation where the

patient attended the centre.

nKPI and
OSR

Yes
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Table 3. Encounter modes (continued)

Automated
Encounter Mode Consu.ltation Description .Included patient
Delivery in reports status
updates?
Dental Room In person Use to record a clinical nKPI and Yes
consultation where OSR
the patient attended a
consulation in the dental
room.
Dispensary - no None Use to record dispensary None No
client contact work for a patient.
Drug and Alcohol In person Use at drug and alcohol nKPI and Yes
Agency agencies to record a clinical | OSR
consultation where the
patient attended the health
service.
Health Care In person Use to record a clinical nKPI and Yes
Practitioner Office consultation for a health OSR
(any discipline) care practitioner that does
not fit any other category.
Health Service In person Use for non-indigenous nKPI and Yes
health services to recorda | OSR
clinical consultation where
the patient attended the
health service.
Hospital - All types | In person Use in hospitals to record a | nKPIl and Yes
clinical consultation where | OSR
the patient attended the
hospital.
Hospital - In person Use in hospital EDs nKPI and Yes
Emergency to record a clinical OSR
Department consultation where the
patient attended the ED.
Hospital - General In person Use in hospital-based nKPI and Yes
Practice general practices to record | OSR
a clinical consultation
where the patient attended
the practice.
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Table 3. Encounter modes (continued)

Encounter Mode

Consultation
Delivery

Description

Included
in reports

Automated
patient
status
updates?

Hostel

In person

Use to record where
workers from the health
service deliver services
at a hostel. Use instead
of creating a separate
encounter place for each
hostel.

nKPI and
OSR

Yes

Inreach

In person

Use to record inreach
consultations.

nKPI and
OSR

Yes

Mobile Clinic

In person

Use to record where
workers from the health
service go out in a mobile
clinic to deliver services.
Use instead of creating a
separate encounter place.

nKPI and
OSR

Yes

Nursing Home

In person

Use to record where
workers from the health
service deliver services at a
nursing home. Use instead
of creating a separate
encounter place for each
centre.

nKPI and
OSR

Yes

Other

In person

Use to record where
workers from the health
service deliver services
at a service encounter or
physical place that is not
otherwise described, read
"Other means" or "Other
service delivery mode".

nKPI and
OSR

Yes

Outreach

In person

Use to record where
workers from the health
service go out into the
community to deliver
services. Use instead

of creating a separate
encounter place.

nKPI and
OSR

Yes
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Table 3. Encounter modes (continued)

Encounter Mode

Consultation

Delivery

Description

Included
in reports

Automated
patient
status
updates?

Prison

In person

Use to record where
workers from the health
service deliver services
at a prison. Use instead
of creating a separate
encounter place for each
prison.

nKPIl and
OSR

Yes

Renal Dialysis
Centre
(Free-standing)

In person

Use to record where
workers from the health
service deliver services

at a freestanding renal
dialysis centre. Use instead
of creating a separate
encounter place for each
centre.

nKPI and
OSR

Yes

Respite Care Facility
(non-Hostel or
Nursing Home)

In person

Use to record where
workers from the health
service deliver services
at a respite care facility.
Use instead of creating a
separate encounter place
for each facility.

nKPI and
OSR

Yes

School

In person

Use to record where
workers from the health
service go to a school to
deliver services. Use instead
of creating a separate
encounter place for each
school or youth club.

nKPI and
OSR

Yes

Supported
residential
accommodation

In person

Use to record where
workers from the health
service deliver services
at supported residential
accommodation. Use
instead of creating a
separate encounter place
for each centre.

nKPI and
OSR

Yes
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Table 3. Encounter modes (continued)

Automated
Encounter Mode Consu.ltation Description ‘Included patient
Delivery in reports status
updates?
Telehealth Video Video Use to record services nKPI and Yes
conferencing |where the contact between | OSR
the Communicare provider
and the patient was using
video conferencing.
Telehealth - Telephone or | Use to record remote nKPI and Yes
Provider by another telehealth consultations. OSR
device such as
a computer,
with or
without video
Telehealth - Facilitator Use where a consultation nKPI and Yes
Recipient only happened between a OSR
provider elsewhere and a
patient, such as between
a specialist and patient
at a hospital, and the
Communicare provider
only facilitated the contact
by providing a room and
remote conferencing
equipment.
Telephone Telephone Use to record a clinical nKPI and Yes
consultation performed OSR
over the telephone between
the Communicare provider
and the patient.
Virtual Clinic Video Use to record video nKPI and Yes
conferencing | healthcare consultation OSR
consultations.

The following services are generally excluded:

« Anyno client contact service.

* The contact service of Admi ni strati on -

* Wi ti ng, Booked or Cancel | ed services.
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* Services provided by providers with a speciality of t ransport worker.
» Services recorded using the Tr ansport module.

« Services recorded for fictitious clients.

|dentifying data required for nKPI reporting
The nKPI reports extract data from clinical items in patient records and Medicare claims.
Conditions

Many of the performance indicators depend on recognising patients because of a documented
condition. This is done by referencing ICPC codes attached to the Communicare condition clinical

items.
System administrators can review ICPC codes.

To review codes for a single condition:

1. Select File > Reference Tables > Clinical Item Types.

2. In the Clinical Item Type Maintenance window, double-click an item and click Advanced.

The ICPC code and term are listed in the ICPC 2 Plus section.

ICFC 2 Phus 0 Oither I

Code [T30  Tem [002 S Ackive

To review all items with the same or similar codes:

1. In the Clinical Item Type Maintenance window, right-click and select Show Hidden Columns.
2. Scroll to the right to find the ICPC Code column and click the header to order by ICPC code.

Type Ho= [ Desciiption= [Chass= [Topic=  [ICPC Codei [ICPC Tem
2000003640 Disbetesron rulin depend  Condition  Endocting, ., | T30 005
2000003717 Diabetes adult onged Condition Endocrine, ... T30 o7
2000003719 Disbetes:Type 2 Condiion  Endocrine, . T30 008
2000008342 Disbetes Type Zineuin ke . Condiion  Endocrine, . T30 T3
2000003639 Hyperglycasris disbetic]  Condition  Endocrine, .. T30 013
2000002696 Beri Beri Condilion  Endocrine, ... T30 o
2000004044 Dehciencynutrtional Condition Endociine, ... | T3 002
2000004051 | Dehiencyvilamin Condiion  Endocrine, .. 91 0

0 Tip:

To move a column, click and drag the header.
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Conditions are recorded in Communicare by adding a clinical item of type Condi t i on to the
patient. For chronic conditions the date of diagnosis is disregarded. For some conditions, if

specified, the date of diagnosis will be required to be within the report period.

- N
Note:
Conditions added to a patient record have no status other than Conpl et e, so all such

items are considered to be confirmed. Any informal comment that may indicate that the

condition is not yet confirmed are disregarded.
- /

For details of which ICPC codes are referenced for specific indicators, check the indicator.

Procedures and immunisations

Because health services may have configured local ways of documenting specific procedures
and immunisations, the reports will often look for a system code or, more often, an export code.

Review codes in the same way as ICPC codes (on page 33).

Because both procedures and immunisations can have a status of Recal |, Cancel | ed,
I nconpl et e or Conpl et e the indicator will consider the status. In most cases the status must
be Conpl et e in order to be counted, but for some indicators, such as PI04 (immunised children),

recalls are considered as well. See each indicator for details.

System codes

Three-character system codes are often used within Communicare to identify clinical items to the
Communicare program but are also used for identifying items for reporting. For example, AHC is

used to identify annual adult Aboriginal health checks.

Note:

No local items should have system codes unless they have been verified as suitable and

correctly identify the item.

To review system codes:

1. Select Report > Reference Tables > System Codes and Rule Codes.
2. To review local items, use the following settings:

o From the Item or qualifier list, select d i nical Itens.

o From the Item or qualifier list, select Local Only.

3. To review central items, use the following settings:
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o From the Item or qualifier list, select d i nical Itens.
o From the Item or qualifier list, select Central Only. To review both local and central

items, select <Al | >.
For details of which system codes are referenced for specific indicators, check the indicator.

Export codes

Export codes are used exclusively for reporting. They can be up to eight characters in length.
For example, CST is used to identify procedures that are evidence of a cervical screening or

equivalent having been performed.

For immunisations, the codes used as export codes are the AIR immunisation codes. For example,

VAXCRP identifies an adult Vaxigrip immunisation when reporting on influenza immunisations.

Review codes in the same way as ICPC codes (on page 33) or run Report > Reference Tables >

System Codes and Rule Codes

For details of which system codes are referenced for specific indicators, check the indicator.

Qualifier codes

Qualifiers are attached to clinical items, and are used in Communicare to capture detailed data
relating to such things as blood pressures, HbAlcs, ACRs, eGFRs, and so on. Because qualifiers
can also be locally defined, we use system codes and export codes to formally identify them for
reporting purposes. For example, an HbAlc recorded as percent has a system code of HBA; for

HbAlcs recorded in mmol/mol, a system code of HBMis used.

Note:

Local qualifiers must be are reviewed for both system and export codes.

To review codes for a single qualifier:

1. Select File > Reference Tables > Qualifier Types.

2. In the Qualifier Type Maintenance window, double-click an item.

The system code is listed in the System Code field.

To review all system and export codes, in the Qualifier Type Maintenance window, right-click and

select Show Hidden Columns.
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T Qualifier Type Maintenance

M 4 = m o= S8 Locate: |
Humber= | Qualfies Description s | alue Type [ Wi |System Code  |Export Code |
10000001 19| Hb [Hasmaghobin) Husmsic gL HEH 0824
|| 1000001943 | Hit e Humeiic ol HEW
] 1000000058 | Hidc (%) Hummetic X HEd
B 1000003071 | HCH Tier Assessment [HARF) T e Fefeiences HARPHCH
| 1000000051 | HOL level Hurmeic ol HIOL

To generate a report of qualifier system codes:

1. Select Report > Reference Tables > > System Codes and Rule Codes.

2. To review local qualifier codes, use the following settings:

o From the Item or qualifier list, select Qualifiers Itens.

o From the Item or qualifier list, select Local Only.

Medicare claims

Where an indicator refers to evidence of a Medicare claim for a specific item or items, the data is

collected on the patient encounter, often referred to in Communicare as a service.

For inclusion in both nKPI and OSR reporting, the claim has only to be selected to be included.

The following statuses are included:

» Sel ect ed

* Sent

» Accept ed (which is interpreted as paid)
* Rej ect ed

Claims that have been discarded by the local claims administrator are excluded from reporting.

Claims can be discarded only following rejection by Medicare.

To assess if a patient has a specific item claimed within a specific time period:

¢ |n the clinical record, click ﬂﬂaims.

¢ |n the Service Record window, on the Medicare tab, click tﬁ:‘

Condition codes reference

‘MBS Items History.

Find the active ICPC-2 PLUS condition codes for NKPI reporting here.
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Diabetes

A patient is recognised as having Type Il diabetes if they have a condition recorded with the ICPC

code of T90. The date of diagnosis is disregarded.

As of December 2021, the active ICPC2-Plus terms for Type Il diabetes used for nKPI reporting are:

Table 4. Diabetes included terms

Condition subgroup

Code

Clinical term

TYPE 2 DIABETES T90005 Diabetes non insulin depend
T90007 Diabetes adult onset
T90009 Diabetes Type 2
T90016 Diabetes Type 2 insulin treated
UNSPECIFIED DIABETES T90002 Diabetes mellitus

To find all terms, use Report > Reference Tables > Clinical Iltem Groups. Use the following

parameters:

¢ Clinical Item or Group - <Al | dinical Items and G oups>

* ICPC Code - 190

COPD

COPD diagnoses are recognised from the ICPC code of R95 or R79. As of December 2021, the

active ICPC2-Plus terms used for nKPI reporting are:

Table 5. COPD included terms

Condition subgroup

Code

Clinical term

CHRONIC BRONCHITIS R79002 Bronchiolitis chronic
R79003 Bronchitis chronic

COPD R95001 Chronic obstr airways disease
R95002 Chronic obstr pulmon disease
R95004 Chronic obstr lung disease
R95008 Chronic airways limitation
R95009 Chronic airways disease

EMPHYSEMA R95006 Emphysema
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To find all terms, use Report > Reference Tables > Clinical Item Groups. Use the following

parameters:

« Clinical Item or Group - <Al | dinical Items and G oups>

* |CPC Code - R95 or R79

CKD

Chronic Kidney Disease diagnoses are recognised from the following ICPC and ICPC2-Plus codes:
U99, U88, U85001.

As of December 2021, the active ICPC2-Plus terms used for nKPI reporting are listed below.

Table 6. CKD included terms

Condition subgroup Code Clinical term

CKD 3 U99037 Chronic kidney disease stage 3
U99037 Disease kidney chronic stage 3
U99043 Disease kidney chronic stage 3A
U99044 Disease kidney chronic stage 3B

CKD 4 U99038 Chronic kidney disease stage 4
U99038 Disease kidney chronic stage 4

CKD 5 U99039 Chronic kidney disease stage 5
U99039 Disease kidney chronic stage 5

DIALYSIS U59001 Dialysis;kidney (renal)
U59008 Haemodialysis

Kidney transplant U28001 Renal transplant

cvD

Cardiovascular disease diagnoses are recognised from the following ICPC and ICPC2-Plus codes:
K89, K90, K91, K92, K74, K75, K76, K52008, K53003, K53007, K53009, K53010, K54007, K91011,
K91014, U99028.

As of December 2021, the active ICPC2-Plus terms used for nKPI reporting are listed below.
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Table 7. CVD included terms

Condition subgroup

Code

Clinical term

ACUTE CORONARY K74001 Angina pectoris
SYNDROME (ACS)/ANGINA K74002 Pain angina
K74004 Unstable angina
K74006 Insufficiency coronary
K74007 IHD with angina
K74008 Acute coronary syndrome
K74008 Acute coronary syndrome
CAROTID ARTERY STENOSIS |K91014 Stenosis artery carotid
K91014 Stenosis, artery, carotid
K91016 Disease carotid
CEREBROVASCULAR DISEASE | K92029 Stroke;lacunar
K92030 Stroke;migrainous
K22 Personal history of cardiovascular
disease (Risk factor for CVD incl)
K89008 Insufficiency vertebrobasilar
K89011 Insufficiency cerebrovascular
K90002 Cerebrovascular accident
K90004 Haemorrhage;subarachnoid
K90006 Haemorrhage cerebral
K90010 Infarction cerebral
K90011 Occlusion cerebral
K90012 Paralysis poststroke/CVA
K90017 Stroke
K90018 Thrombosis artery cerebral
K90018 Thrombosis;artery;cerebral
K90020 Embolism;cerebral
K90025 Paresis poststroke/CVA
K90026 Hemiparesis post stroke/CVA
K91006 Disease cerebrovascular
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Table 7. CVD included terms (continued)

Condition subgroup

Code

Clinical term

K91007 Cerebral artery aneurysm
K91008 Occlusion precerebral
K91009 Ischaemia cerebral
K91010 Stroke/cva old
K91011 Stenosis arterial precerebral
K91012 Thrombosis artery precerebral
K91013 Embolism;precerebral
K91014 Stenosis;artery;carotid
K91015 Atherosclerosis cerebral
K92018 Embolism, arterial

CEREBROVASCULAR DISEASE | K89001 Transient ischaemic attack

- TIA K89004 Vertebral artery syndrome
K89005 Basilar artery syndrome
K89008 Insufficiency basilar
K89015 RIND syndrome

CORONARY HEART DISEASE K74006 Insufficiency coronary
K74007 IHD with angina
K75004 Occlusion coronary
K75008 Thrombosis artery coronary
K76005 Disease atherosclerotic heart
K76008 Ischaemia myocardial chronic
K76011 Disease ischaem heart subacute
K76013 Coronary artery disease
K76013 Coronary heart disease
K76014 Disease ischaemic heart
K76015 Disease ischaem heart chronic
K76018 IHD without angina
K76019 Atherosclerosis coronary
K92007 Occlusion arterial
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Table 7. CVD included terms (continued)

Condition subgroup

Code

Clinical term

K92022 Stenosis artery

K92024 Atherosclerosis

K92025 Arteriosclerosis

K92028 Insufficiency vascular

K92030 Atherosclerosis aorta

K92031 Disease small vessel

K75009 Embolism artery coronary
MYOCARDIAL INFARCTION K75001 Infarction heart

K75002 Infarction myocardial acute

K75010 Infarction impending

K75011 Postmyocardial infarct syndrome

K75013 Infarction myocardial

K75014 Heart attack

K75015 Myocardial infarction STEMI

K75016 Myocardial infarction non STEMI

K76006 Infarction myocardial healed

K76006 Infarction myocardial old
PERIPHERAL VASCULAR K92030 Arteriosclerosis;obliterans
DISEASE (PVD) K92003 Disease peripheral vascular
RENAL ARTERY STENOSIS U99028 Stenosis;artery;renal
SURGERY - CARDIOVASCULAR |K52008 Endarterectomy internal carotid
- CAROTID K53007 Stent(s) carotid

K91016 Disease carotid
SURGERY - CARDIOVASCULAR [K53003 Angioplasty;artery;coronary
- CORONARY K53009 Stent(s)coronary

K54007 Graft coronary artery bypass

SURGERY - CARDIOVASCULAR
- RENAL ARTERY

Code not available

Renal artery stenosis - Stent
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Procedure, Immunisation, Pathology & Medicare codes reference

Find the active ICPC-2 PLUS Procedure, Immunisation, Pathology and Medicare codes for NKPI

reporting here.

Annual Health Assessments

Currently (February 2018) annual health assessments are only referenced in nKPls by the
associated Medicare claim (715, 228, 92004, 92016, 92011, 92023).

For OSR reporting the following System Codes are referenced on clinical items only whenever a
patient has no claim for Medicare item 715 (or 228, 92004, 92016, 92011, 92023):

e AHC for adult annual health checks
e CHC for child annual health checks

e OHC for over-55s annual health checks

Care Plans

Currently (February 2018) care plans are only referenced in nKPIs by the associated Medicare
claim (721 721, 229, 92024, 92068, 92055, 92099).

* The System Code used to identify care plan assessments is CPA.

» The System Code used to identify Team Care Arrangements is TCA.

Pregnancy and Cervical Screening Items

These Rule Codes are referenced:

¢ PR- CHECK - any procedure identified by this rule code will be deemed to be an antenatal
check. By checking the pregnancy number and then looking for an explicit gestation or by
comparing with the pregnancy outcome, the trimester in which the first antenatal check

was performed can be calculated.
These Export Codes are referenced:

» CST, HPV, LBC - any procedure that is evidence that a cervical screening test, human

papillomavirus or liquid based cytology has been performed.

Substance Use (Drug and Alcohol) Items

These Export Codes are referenced:
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* DA- ENROL - identifies a formal enrolment to a course of drug and alcohol treatment.
If this clinical item has a reference qualifier with an export code of ‘DA-TDS’ where a
reference with an export code of 2 has been recorded then the treatment is deemed to be
residential.

e DA- EXI T - formally marks the end of a period of drug and alcohol treatment.

* DR- ENROL - identifies the start of a period of respite for patients receiving drug and
alcohol treatment.

e DR- EXI T - formally marks the end of a period of respite.

« DA- SUCS - identifies an occasion of sobering up during an overnight stay

Immunisations

Influenza immunisations are recognised using the Export Codes on clinical items of type
| muni sati on; brand code for the GNFLU vaccine and its equivalents, described in
Equivalent and partial equivalent vaccines table - GNFLU entry. For example, GNFLU, PANVAX,

FLUVAX, and so on. These vaccines may change annually.

o ™
Note:
Listed in the Non-standard vaccines and Equivalent and partial equivalent vaccines tables

are:

» COVID-19 vaccines. For example, AstraZeneca COVISHIELD (ASTCQOV), Bharat
Biotech Covaxin (BHACQV), Pfizer Comirnaty (COMIRN), Immunisation;Pfizer
Bivalent (COMBIV), AstraZeneca Vaxzevria (COVAST), Gamaleya Sputnik V
(GAMSPU), Moderna Spikevax (MODERN), Moderna Bivalent Spikevax (MODBIV),
Novavax NUVAXOVID (NOVNUV), Sinovac Coronavac (SINCOR).

* Monkey Pox vaccines. For example, ACAM2000 (ACAM), Generic Smallpox (GNPOX),
JYNNEOS (JYNNEO).

« Japanese Encephalitis vaccines. For example, Imojev (IMOINT), IXIARO (IXIARO).

* Meningococcal vaccines. For example, MenQuadfi (MENQDF).

o j

For customers using the Immunisation Vaccines dataset, example codes include:

¢ Immunisation;flu, GNFLU
* Immunisation;influenza, GNFLU

¢ Immunisation;Afluria Quad, AFLR
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e Immunisation;Afluria Quad (NIP), AFLQUA

* Immunisation;Afluria Quad (Non-NIP), QUADAF
¢ Immunisation;Agrippal, AGRPAL

» Immunisation;Flucelvax Quad, FCELOD

« Immunisation;Fluzone High-Dose Quad, FLHDQD
* Immunisation;Fluarix, FLRIX

¢ Immunisation;Fluarix Tetra, FLUTET

» Immunisation;Fluarix Tetra (NIP), FLXTET

« Immunisation;Fluarix Tetra (Non-NIP, ARXFLU

* Immunisation;Fluad, FLUAD

¢ Immunisation;Fluzone High-Dose, FLUHID

* Immunisation;Fluad Quad, FLUQAD

¢ Immunisation;Fluarix Tetra, FLUTET

* Immunisation;bioCSL Fluvax, FLUVAX

¢ Immunisation;Fluvirin, FLVRN

* Immunisation;FluQuadri Junior, FODJN

e Immunisation;FluQuadri, FQUAD

* Immunisation;Fluvax Junior, FVXJNR

¢ Immunisation;Influvac Tetra, INFLTA

* Immunisation;Influvac, INFLUV

¢ Immunisation;Panvax (H1N1 Influenza), PANVAX
* Immunisation;Panvax (HIN1) 0.25ml, PANVAX
¢ Immunisation;Panvax (H1N1) 0.5ml, PANVAX

* Immunisation;Vaxelis, VAXLIS

¢ Immunisation;Vaxigrip, VAXGRP

» Immunisation;Vaxigrip Tetra, VAXTET

« Immunisation;Vaxigrip Junior, VGRJNR

Immunisation Reviews

Immunisation reviews must be named as indicated here (case insensitive):

* Starts with REVIEW;IMMUNISATION;6 MONTH
« Starts with REVIEW;IMMUNISATION;12 MONTH
* Starts with REVIEW;IMMUNISATION;18 MONTH
e Starts with REVIEW;IMMUNISATION;4 YEAR
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Export codes were introduced for June 2018 reporting and are included here for health services

who wish to name their immunisation review items differently:

¢ IMRV-BIR REVIEW;IMMUNISATION;BIRTH

* IMRV-02M REVIEW;IMMUNISATION;2 MONTH
¢ IMRV-04M REVIEW;IMMUNISATION;4 MONTH
* IMRV-06M REVIEW;IMMUNISATION;6 MONTH
¢ IMRV-12M REVIEW;IMMUNISATION;12 MONTH
* IMRV-18M REVIEW;IMMUNISATION;18 MONTH
¢ IMRV-04Y REVIEW;IMMUNISATION;4 YEAR

* IMRV-12Y REVIEW;IMMUNISATION;12 YEAR

¢ IMRV-50Y REVIEW;IMMUNISATION;50 YEAR

Group Activity

For OSR group activity recording the following export codes are recognised as group activity:

« HP-GRPT will be resolved as "Tobacco use treatment/prevention groups'
» HP-GRPA will be resolved as ‘Alcohol misuse treatment/prevention grps.
* HP-GRPP will be resolved as 'Physical activity/healthy wt activities"

* HP-GRPC will be resolved as 'Chronic disease client support groups.

« HP-GRPL will be resolved as 'Living skills groups.

* HP-GRPU will be resolved as 'Cultural groups.

« HP-GRPM will be resolved as 'Men's groups.

* HP-GRPW will be resolved as "'Women's groups.

« HP-GRPY will be resolved as 'Youth groups.

» HP-GRP will be resolved as the name of the clinical item.
These additional codes are used for the maternal and child health group activities:

* MCH-GRPA will be resolved as ‘Antenatal groups.
* MCH-GRPM will be resolved as 'Maternal and baby/child health groups.
* MCH-GRPP will be resolved as 'Parenting and parenting skills groups.

« MCH-GRP will be resolved as the name of the clinical item.
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Pathology

For some indicators, reference is made to pathology requests or results recorded in a patient
record. For example, cervical screenings can be identified by the recording of a clinical item or a

qualifier but also by the recording of a test request or the receiving of a test result.

Test Requests

Cervical screening: Request terms with the keywords of CST, HPV, or LBC will be recognised as

requests for cervical screening test, human papillomavirus or liquid based cytology.

Review your request term keywords at File > Reference Tables > Investigations > Investigation

Keywords.

To print out a list, run the report at Report > Reference Tables > Investigation Keywords.

Test Results

For cervical screening, results are recognised if the name of the test returned by the lab includes

any of the following strings of text (all case insensitive):

« CST

« HPV

« LBC

» CERVICAL SCREEN

* GYNAECOLOGICAL CYTOLOGY
* NCSP

Medicare Claims

The following Medicare claim numbers are referred to in the nKPI indicators:

« 715 (228, 92004, 92016, 92011, 92023): [nKPI, OSR] Annual health assessments for
Indigenous patients.
* 721 (229, 92024, 92068, 92055, 92099): [nKPI, OSR] GP management plans
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» 10986: [OSR only] Healthy Kids Check performed by nurse or Aboriginal Health

Practitioner.

Note:

This Medicare item was made inactive on 1st November 2015 but the indicator still

references this item.

Health Care Home Trial

Enrolment in the Health Care Home Trial is managed using clinical items with these codes:

* HC-ENROL - this should be the rule code and export code for the enrolment item
* HC-EXIT - this should be the rule code and export code for the exit item

Qualifiers reference

Find the active ICPC-2 PLUS qualifier codes for NKPI reporting here.

Numeric qualifiers

These System Codes are referenced in each specific indicator but are reproduced here for general

reference:

* BPS - Systolic blood pressure measured in mmHg

« BPD - Diastolic blood pressure measured in mmHg

* WKG - Patient weight in kg

¢ HCM - Patient height in cm

* BMI - Patient BMI

* HBH - HbAlcin %

« HBM - HbA1c in mmol/mol

¢ ACR - Albumin creatinine ratio

* GFE - eGFR (estimated glomerular filtration rate) in mL/min/1.73m?2
e CHO - Total cholesterol level in mmol/L

¢ HDL - HDL level in mmol/L

¢ CHR - Total cholesterol level/HDL ratio

» GSA - Gestational age at birth in weeks recorded in the baby’s record)

¢ GST - Gestation in weeks (recorded in the mother’s record)

These Export Codes are referenced:
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« AUDITC - Alcohol audit C score

* AAQ99 - Full alcohol audit score

¢ CVR-NO5F - Framingham cardiovascular risk recorded in %
» CVR-NO5C - CARPA cardiovascular risk recorded in %

Reference qualifiers

These System Codes are referenced in each specific indicator but are reproduced here for general

reference:

* SMO - Smoking Status where the dropdown references have a system code of S, N, or E
(smoker, non-smoker and ex-smoker). Note that for local qualifiers a system code of U may
be used if there is an option that does not define any of the three categories - it will be
reported as ‘Undefined’.

* SMP - Smoking during pregnancy where the dropdown references have a system code of S,
N, or E (smoker, non-smoker and ex-smoker). Note that for local qualifiers a system code of
U may be used if there is an option that does not define any of the three categories — it will
be reported as ‘Undefined’.

* ALC - Alcohol consumption where the dropdown references have a system code of D, N, or
E (drinker, non- drinker and ex- drinker).

* ALP - Alcohol during pregnancy where the dropdown references have a system code of D,

N, or E (drinker, non-drinker and ex-drinker).
These Export Codes are referenced:

« DA- TDS - Treatment delivery setting (for residential drug and alcohol treatment)

* AAQO1 - Alcohol audit question 1 - "How often do you have a drink containing alcohol?".
The export code of the dropdown reference is the allocated score.

* AAQD?2 - Alcohol audit question 2 - "How many drinks containing alcohol do you have on
a typical day when you are drinking?". The export code of the dropdown reference is the
allocated score.

¢ CVR- RO5F - cardiovascular risk recorded as a reference qualifier where the dropdown
references have a system code of H, M, L or U (high, moderate, low and unknown).

¢ CVR- RO5C - cardiovascular risk recorded as a reference qualifier where the dropdown
references have a system code of H, M, L or U (high, moderate, low and unknown).

¢ CT- RSLT or TTANGO Chl anydi a - use with any existing local qualifiers currently used to
record POC STI testing to show that a chlamydia result has been received for P125.

* NG RSLT or TTANGO Gonnor r hoea - use with any existing local qualifiers currently

used to record POC STI testing to show that a gonorrhoea result has been received for P125.
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Miscellaneous qualifiers

These Export Codes are referenced in each specific indicator:

* CST, HPV, LBC - Any Yes/No or checkbox qualifier with this export code is deemed to be

evidence of a cervical screening test, human papillomavirus or liquid based cytology if the

value is True (i.e. the response is Yes or the qualifier is selected).

Client Contact Types reference

Each Communicare speciality type is mapped to a reporting category provided by AIHW.

OSR Provider Type Mapping

Communicare specialty workers are shown in uppercase below.

Table 8. Communicare to AIHW provider type mapping

Communicare Specialty

OSR Contact Type Mapping
(Health Provider roles)

ABORIGINAL AND TSI HEALTH PRACTITIONER

Aboriginal and Torres Strait Islander Health
Practitioner

ABORIGINAL AND TSI HEALTH WORKER

Aboriginal and Torres Strait Islander Health
Worker

ABORIGINAL COMMUNITY SUPPORT WORKER

Other health / clinical staff

ABORIGINAL FAMILY HEALTH WORKER

Aboriginal and Torres Strait Islander Health
Worker

ABORIGINAL LIAISON OFFICER

Other health / clinical staff

ABORIGINAL MENTAL HEALTH WORKER

Social and Emotional Well Being staff | SEWB
staff other or not specified

ABORIGINAL AND TSI MENTAL HEALTH
WORKER

Social and Emotional Well Being staff | SEWB
staff other or not specified

ACUPUNCTURIST

Allied health other or not specified

AGED CARE COORDINATOR

Other health / clinical staff

ALLIED HEALTH AIDE

Allied health other or not specified

ALTERNATIVE THERAPIST

Allied health other or not specified

AMBULANCE OFFICER

Other health / clinical staff

ANAESTHETIST

Specialist other or not specified
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Table 8. Communicare to AIHW provider type mapping (continued)

Communicare Specialty

OSR Contact Type Mapping
(Health Provider roles)

ASSISTANT IN NURSING

Other health / clinical staff

ASTHMA EDUCATOR

Allied health other or not specified

ATTENDANT CARER

Allied health other or not specified

AUDIOLOGIST

Audiologist / Audiometrists

BTH COUNSELLOR

Counsellors

CARDIAC EDUCATOR

Allied health other or not specified

CARDIOLOGIST

Cardiologist

CARDIOTHORACIC PHYSIOTHERAPIST

Allied health other or not specified

CARDIOTHORACIC SURGEON

Medical Specialist | Surgeon

CHILD CARE WORKER

Other health / clinical staff

CHILD HEALTH NURSE

Nurses

CHIROPRACTOR

Allied health other or not specified

CHRONIC CARE COORDINATOR

Allied health other or not specified

CLERICAL / ADMINISTRATIVE WORKER

Other health / clinical staff

CLINICAL ALLERGIST

Other health / clinical staff

CLINICAL CYTOPATHOLOGIST

Medical Specialist | Specialist other or not
specified

CLINICAL HAEMATOLOGIST

Medical Specialist | Specialist other or not
specified

CLINICAL PHARMACOLOGIST

Medical Specialist | Specialist other or not
specified

CLINICAL PSYCHOLOGIST

Social and Emotional Well Being staff |
Psychologist

COMMUNITY / FAMILY REPRESENTATIVE

Other health / clinical staff

COMMUNITY PARAMEDICAL

Allied health other or not specified

COMMUNITY SERVICES WORKER

Other health / clinical staff

COUNSELLOR

Counsellors

DAY CARE WORKER

Other health / clinical staff
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Table 8. Communicare to AIHW provider type mapping (continued)

Communicare Specialty

OSR Contact Type Mapping
(Health Provider roles)

DENTAL - TECHNICIAN OR PROSTHETIST

Dental support (e.g. dental assistant / dental
technician)

DENTAL ASSISTANT

Dental support (e.g. dental assistant / dental
technician)

DENTAL HYGIENIST

Dentists / dental therapists

DENTAL PROSTHETIST

Dental support (e.g. dental assistant / dental
technician)

DENTAL SPECIALIST

Dentists / dental therapists

DENTAL TECHNICIAN

Dental support (e.g. dental assistant / dental
technician)

DENTAL THERAPIST

Dentists / dental therapists

DENTIST

Dentists / dental therapists

DERMAL CLINICIAN

Allied Health Professional | Allied health other
or not specified

DERMATOLOGIST

Dermatologist

DIABETES EDUCATOR

Diabetes Educators

DIETITIAN

Dieticians

DISABILITY SERVICES WORKER

Allied health other or not specified

DRUG AND ALCOHOL COUNSELLOR

Substance misuse / drug and alcohol worker

EAR NOSE AND THROAT SPECIALIST

Ear Nose and Throat Specialist

EMERGENCY MEDICINE SPECIALIST

Specialist other or not specified

EMOTIONAL AND SOCIAL WELLBEING STAFF

Social and Emotional Well Being staff | SEWB
staff other or not specified

ENDOCRINOLOGIST

Endocrinologist

ENROLLED NURSE

Nurses

ENROLLED NURSE (MENTAL HEALTH)

Nurses

ENVIRONMENTAL HEALTH OFFICER

Allied health other or not specified

EPIDEMIOLOGIST

Other health / clinical staff

EXERCISE PHYSIOLOGIST

Allied health other or not specified

EYE HEALTH COORDINATOR

Allied health other or not specified
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Table 8. Communicare to AIHW provider type mapping (continued)

Communicare Specialty

OSR Contact Type Mapping
(Health Provider roles)

FAMILY VIOLENCE CASE MANAGER

Social and Emotional Well Being staff | SEWB
staff other or not specified

FAMILY VIOLENCE COORDINATOR

Social and Emotional Well Being staff | SEWB
staff other or not specified

FAMILY VIOLENCE COUNSELLOR

Social and Emotional Well Being staff |
Counsellor

GASTROENTEROLOGIST

Specialist other or not specified

GENERAL MEDICAL PRACTITIONER

Doctor - General Practitioner

GERIATRICIAN

Medical Specialist | Specialist other or not
specified

GYNAECOLOGICAL ONCOLOGIST

Medical Specialist | Specialist other or not
specified

HEALTH DIAGNOSIS/TREATMENT
PRACTITIONER

Allied health other or not specified

HEALTH INFORMATION MANAGER

Other health / clinical staff

HEALTH PRACTICE MANAGER

Other health / clinical staff

HEALTH PROMOTION OFFICER

Other health / clinical staff

HOME CARE WORKER

Allied health other or not specified

HOME HELP WORKER

Other health / clinical staff

HOMOEOPATH

Allied health other or not specified

HOSPITAL SCIENTIST

Other health / clinical staff

IMMUNOLOGIST

Medical Specialist | Specialist other or not
specified

INFECTIOUS DISEASES PHYSICIAN

Medical Specialist | Specialist other or not
specified

INFECTIOUS DISEASES SPECIALIST

Specialist other or not specified

INTENSIVE CARE ANAESTHETIST

Medical Specialist | Specialist other or not
specified

INTENSIVE CARE MEDICINE SPECIALIST

Medical Specialist | Specialist other or not
specified

INTERPRETER/TRANSLATOR

Other health / clinical staff
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Table 8. Communicare to AIHW provider type mapping (continued)

Communicare Specialty

OSR Contact Type Mapping
(Health Provider roles)

MASSAGE THERAPIST

Allied health other or not specified

MEALS/FOOD SERVICES WORKER

Other health / clinical staff

MEDICAL DIAGNOSTIC RADIOGRAPHER

Specialist other or not specified

MEDICAL INTERN

Other health / clinical staff

MEDICAL ONCOLOGIST

Medical Specialist | Specialist other or not
specified

MEDICAL PRACTITIONER IN TRAINING

Other health / clinical staff

MEDICAL RECEPTIONIST

Other health / clinical staff

MIDWIFE

Midwives

MOTHERCRAFT NURSE

Nurses

MUSIC THERAPIST

Allied Health Professional | Allied health other
or not specified

NATURAL THERAPY PROFESSIONAL

Allied health other or not specified

NATUROPATH

Allied health other or not specified

NEPHROLOGIST

Renal Medicine Specialist

NEUROLOGIST

Specialist other or not specified

NEUROPSYCHOLOGIST

Social and Emotional Well Being staff |
Psychologist

NEUROSURGEON

Medical Specialist | Surgeon

NUCLEAR MEDICINE TECHNOLOGIST

Specialist other or not specified

NURSE EDUCATOR Nurses
NURSE MANAGER Nurses
NURSE PRACTITIONER Nurses
NURSE RESEARCHER Nurses

OBSTETRICIAN AND GYNAECOLOGIST

Obstetrician / Gynaecologist

OCCUPATIONAL THERAPIST

Allied health other or not specified

OPHTHALMOLOGIST

Ophthalmologist

ORAL AND MAXILLOFACIAL SURGEON

Medical Specialist | Surgeon

ORTHOPAEDIC SURGEON

Medical Specialist | Surgeon
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Table 8. Communicare to AIHW provider type mapping (continued)

Communicare Specialty

OSR Contact Type Mapping
(Health Provider roles)

OPTOMETRIST

Optometrists

ORTHOPTIST

Specialist other or not specified

ORTHOTIC PROSTHETIST

Allied health other or not specified

ORTHOTIST

Allied health other or not specified

OSTEOPATH

Allied health other or not specified

OTHER PROFESSION/DISCIPLINE

Other health / clinical staff

PAEDIATRICIAN

Paediatrician

PALLIATIVE MEDICINE PHYSICIAN

Medical Specialist | Specialist other or not
specified

PATHOLOGIST

Specialist other or not specified

PERSONAL CARE ASSISTANT

Allied health other or not specified

PHARMACIST

Pharmacists

PHARMACY TECHNICIAN

Other health / clinical staff

PHLEBOTOMIST

Other health / clinical staff

PHYSICIAN"S ASSISTANT

Other health / clinical staff

PHYSIOLOGIST

Allied Health Professional | Allied health other

or not specified

PHYSIOTHERAPIST

Allied Health Professional | Physiotherapist

PLASTIC AND RECONSTRUCTIVE SURGEON

Medical Specialist | Surgeon

PODIATRIST

Podiatrists

PRINCIPAL HOUSE OFFICER

Doctor - General Practitioner

PSYCHIATRIST

Psychiatrist / Psychiatric Register

PSYCHOLOGIST

Social and Emotional Well Being staff |
Psychologist

PSYCHOTHERAPIST

Social and Emotional Well Being staff | SEWB
staff other or not specified

PUBLIC HEALTH PHYSICIAN

Medical Specialist | Specialist other or not
specified

RADIOLOGIST

Specialist other or not specified
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Table 8. Communicare to AIHW provider type mapping (continued)

Communicare Specialty

OSR Contact Type Mapping
(Health Provider roles)

RADIOTHERAPIST

Specialist other or not specified

RADIATION ONCOLOGIST

Medical Specialist | Specialist other or not
specified

RECREATION WORKER Other health / clinical staff
REGISTERED NURSE Nurses
REGISTERED NURSE (DEVT""L DISABILITY) Nurses
REGISTERED NURSE (MENTAL HEALTH) Nurses

REGISTERED PARAMEDIC

Other health / clinical staff

REGISTRAR

Doctor - General Practitioner

REHABILITATION AIDE

Allied health other or not specified

RENAL MEDICINE SPECIALIST

Renal Medicine Specialist

RESIDENT MEDICAL OFFICER

Doctor - General Practitioner

RESPIRATORY PHYSICIAN

Medical Specialist | Specialist other or not
specified

RESPIRATORY PHYSIOTHERAPIST

Allied Health Professional | Physiotherapist

RHEUMATOLOGIST

Specialist other or not specified

SEXUAL HEALTH PHYSICIAN

Medical Specialist | Specialist other or not
specified

SEXUAL HEALTH WORKER

Sexual health worker

SMOKING CESSATION COORDINATOR

Tobacco worker / co-ordinator

SMOKING CESSATION OFFICER

Tobacco worker / co-ordinator

SOCIAL WORKER

Social Workers

SONOGRAPHER

Other health / clinical staff

SPECIALIST MEDICAL PRACTITIONER

Specialist other or not specified

SPECIALIST PHYSICIAN

Specialist other or not specified

SPEECH PATHOLOGIST

Allied Health Professional | Speech Pathologist

SPEECH THERAPIST

Allied Health Professional | Speech Pathologist

SUBSTANCE MISUSE WORKER

Substance misuse / drug and alcohol worker

SURGEON

Medical Specialist | Surgeon
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Table 8. Communicare to AIHW provider type mapping (continued)

Communicare Specialty

OSR Contact Type Mapping
(Health Provider roles)

TEAM. AGED CARE ASSESSMENT TEAM (ACAT)

Allied health other or not specified

TEAM. MULTI-DISCIPLINARY TEAM

Allied health other or not specified

TEAM. PSYCHOGERIATRIC ASSESS TEAM
(PGAT)

Social and Emotional Well Being staff | Welfare
Worker

TECHNICIAN

Other health / clinical staff

THERAPIST'S ASSISTANT

Other health / clinical staff

THERAPY AIDE

Other health / clinical staff

TRADITIONAL HEALER

Traditional healer

TRANSPORT WORKER Transport (health professionals who work for
the service)
UROLOGIST Medical Specialist | Specialist other or not

specified

VASCULAR SURGEON

Medical Specialist | Surgeon

VETERINARIAN

Specialist other or not specified

VOLUNTARY WORKER

Other health / clinical staff

WELFARE WORKER

Social and Emotional Well Being staff | Welfare
Worker

YOUTH WORKER

Social and Emotional Well Being staff | Welfare
Worker

-~

Note:

N

Any other speciality types that may be added from time to time will be mapped to Other
health / clinical staff unless there is a clear mapping available. In some cases, this may

be a temporary mapping pending a decision from the AIHW as to the preferred grouping.

/

Healthcare Provider Type Mapping

HCP inputs are collected for all providers who provided Medicare rebated services in the financial

year.

Communicare specialty workers are shown in uppercase below.
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Table 9. HCP Type Mapping

Communicare Specialty

Health Care Provider Type

ABORIGINAL AND TSI HEALTH WORKER

ATSI Health Worker

ABORIGINAL FAMILY HEALTH WORKER

ATSI| Health Worker

ABORIGINAL AND TSI HEALTH PRACTITIONER

ATSI Health Practitioner

GENERAL MEDICAL PRACTITIONER

Doctor - General Practitioner

CHILD HEALTH NURSE

Nurse practitioner

ENROLLED NURSE

Nurse practitioner

MOTHERCRAFT NURSE

Nurse practitioner

NURSE EDUCATOR

Nurse practitioner

NURSE MANAGER

Nurse practitioner

NURSE PRACTITIONER

Nurse practitioner

NURSE RESEARCHER

Nurse practitioner

REGISTERED NURSE

Nurse practitioner

REGISTERED NURSE (DEVT'L DISABILITY)

Nurse practitioner

REGISTERED NURSE (MENTAL HEALTH)

Nurse practitioner

REGISTERED PARAMEDIC

Other health / clinical staff

MIDWIFE

Midwives

DRUG AND ALCOHOL COUNSELLOR

Substance misuse / drug and alcohol worker

SUBSTANCE MISUSE WORKER

Substance misuse / drug and alcohol worker

SMOKING CESSATION COORDINATOR

Tobacco worker / co-ordinator

SMOKING CESSATION OFFICER

Tobacco worker / co-ordinator

DENTAL HYGIENIST

Dentists / dental therapists

DENTAL SPECIALIST

Dentists / dental therapists

DENTAL THERAPIST

Dentists / dental therapists

DENTIST

Dentists / dental therapists

DENTAL - TECHNICIAN OR PROSTHETIST

Dental support (e.g. dental assistant / dental
technician)

DENTAL ASSISTANT

Dental support (e.g. dental assistant / dental
technician)

DENTAL PROSTHETIST

Dental support (e.g. dental assistant / dental
technician)
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Table 9. HCP Type Mapping (continued)

Communicare Specialty Health Care Provider Type

DENTAL TECHNICIAN Dental support (e.g. dental assistant / dental
technician)

SEXUAL HEALTH WORKER Sexual health worker
TRADITIONAL HEALER Traditional healer
ABORIGINAL LIASION OFFICER Other health / clinical staff
AMBULANCE OFFICER Other health / clinical staff
CHILD CARE WORKER Other health / clinical staff
CLERICAL / ADMINISTRATIVE WORKER Other health / clinical staff
COMMUNITY / FAMILY REPRESENTATIVE Other health / clinical staff
COMMUNITY SERVICES WORKER Other health / clinical staff
DAY CARE WORKER Other health / clinical staff
HEALTH PRACTICE MANAGER Other health / clinical staff
HOME HELP WORKER Other health / clinical staff
INTERPRETER/TRANSLATOR Other health / clinical staff
MEALS/FOOD SERVICES WORKER Other health / clinical staff
MEDICAL RECEPTIONIST Other health / clinical staff
OTHER PROFESSION/DISCIPLINE Other health / clinical staff
PHARMACY TECHNICIAN Other health / clinical staff
SONOGRAPHER Other health / clinical staff
TECHNICIAN Other health / clinical staff
VOLUNTARY WORKER Other health / clinical staff
HEALTH INFORMATION MANAGER Other health / clinical staff
HEALTH PROMOTION OFFICER Other health / clinical staff
MEDICAL INTERN Other health / clinical staff
MEDICAL PRACTITIONER IN TRAINING Other health / clinical staff
RECREATION WORKER Other health / clinical staff
REGISTRAR "Doctor - General Practitioner
RESIDENT MEDICAL OFFICER Other health / clinical staff
RESPIRATORY PHYSICIAN Specialist other or not specified
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Table 9. HCP Type Mapping (continued)

Communicare Specialty

Health Care Provider Type

RESPIRATORY PHYSIOTHERAPIST

Physiotherapist

TRANSPORT WORKER

Transport - work for service”

PAEDIATRICIAN

Paediatrician”

ENDOCRINOLOGIST

Endocrinologist”

OPHTHALMOLOGIST

Ophthalmologist”

OBSTETRICIAN AND GYNAECOLOGIST

Obstetrician / Gynaecologist

EAR, NOSE AND THROAT SPECIALIST

Ear Nose and Throat Specialist

CARDIOLOGIST

Cardiologist

CARDIOTHORACIC PHYSIOTHERAPIST

Physiotherapist

RENAL MEDICINE SPECIALIST

Renal Medical Specialist

PSYCHIATRIST

Psychiatrist/Psychiatric Register

DERMATOLOGIST

Dermatologist

SURGEON

Surgeon

ANAESTHETIST

Specialist other or not specified

EMERGENCY MEDICINE SPECIALIST

Specialist other or not specified

GASTROENTEROLOGIST

Specialist other or not specified

MEDICAL DIAGNOSTIC RADIOGRAPHER

Specialist other or not specified

NEUROLOGIST

Specialist other or not specified

NUCLEAR MEDICINE TECHNOLOGIST

Specialist other or not specified

ORTHOPTIST

Specialist other or not specified

OTORHINOLARYNGOLOGIST

Specialist other or not specified

PATHOLOGIST

Specialist other or not specified

RADIOLOGIST

Specialist other or not specified

RADIOTHERAPIST

Specialist other or not specified

SPECIALIST MEDICAL PRACTITIONER

Specialist other or not specified

SPECIALIST PHYSICIAN

Specialist other or not specified

VETERINARIAN

Specialist other or not specified

INFECTIOUS DISEASE SPECIALIST

Specialist other or not specified

PSYCHOLOGIST

Psychologist
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Table 9. HCP Type Mapping (continued)

Communicare Specialty

Health Care Provider Type

CLINICAL PSYCHOLOGIST

Psychologist

BTH COUNSELLOR Counsellor
COUNSELLOR Counsellor
SOCIAL WORKER Social Worker

ABORIGINAL MENTAL HEALTH WORKER

Social and Emotional Well Being staff | SEWB
staff other or not specified

EMOTIONAL AND SOCIAL WELLBEING STAFF

Social and Emotional Well Being staff | SEWB
staff other or not specified

TEAM. PSYCHOGERIATRIC ASSESS TEAM
(PGAT)

Social and Emotional Well Being staff | SEWB
staff other or not specified

YOUTH WORKER

Social and Emotional Well Being staff | SEWB
staff other or not specified

AUDIOLOGIST

Audiologist/Audiometrist

DIABETES EDUCATOR

Diabetes educator

DIETITIAN

Dietician

OPTOMETRIST

Optometrist

PHARMACIST

Pharmacist

PHYSIOTHERAPIST

Physiotherapist

PODIATRIST

Podiatrist

SPEECH PATHOLOGIST

Speech Pathologist

ACUPUNCTURIST

Allied health other or not specified

ALLIED HEALTH AIDE

Allied health other or not specified

ALTERNATIVE THERAPIST

Allied health other or not specified

ASTHMA EDUCATOR

Allied health other or not specified

ATTENDANT CARER

Allied health other or not specified

CHIROPRACTOR

Allied health other or not specified

COMMUNITY PARAMEDICAL

Allied health other or not specified

DISABILITY SERVICES WORKER

Allied health other or not specified

ENVIRONMENTAL HEALTH OFFICER

Allied health other or not specified

EXERCISE PHYSIOLOGIST

Allied health other or not specified
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Table 9. HCP Type Mapping (continued)

Communicare Specialty

Health Care Provider Type

EYE HEALTH COORDINATOR

Allied health other or not specified

HEALTH DIAGNOSIS/TREATMENT

Allied health other or not specified

PRACTITIONER

Allied health other or not specified

HOME CARE WORKER

Allied health other or not specified

HOMOEOPATH

Allied health other or not specified

MASSAGE THERAPIST

Allied health other or not specified

NATURAL THERAPY PROFESSIONAL

Allied health other or not specified

NATUROPATH

Allied health other or not specified

OCCUPATIONAL THERAPIST

Allied health other or not specified

ORTHOTIC PROSTHETIST

Allied health other or not specified

ORTHOTIST

Allied health other or not specified

OSTEOPATH

Allied health other or not specified

PERSONAL CARE ASSISTANT

Allied health other or not specified

PSYCHOTHERAPIST

Allied health other or not specified

REHABILITATION AIDE

Allied health other or not specified

TEAM. AGED CARE ASSESSMENT TEAM (ACAT)

Allied health other or not specified

TEAM. MULTI-DISCIPLINARY TEAM

Allied health other or not specified

CARDIAC EDUCATOR

Allied health other or not specified

CHRONIC CARE COORDINATOR

Allied health other or not specified

Reporting parameters

Reporting periods

National KPI reports are due at the end of the calendar year and the end of the financial year (31
December and 30 June). The nominal report period is one year but some of the reports are ‘point
in time’ assessments as of the end of the report period. In these cases, there will be a currency

period defined. For example, patients who, at the end of the report period, have had an HbAlc in

the previous six months. See each indicator for details.




The OSR reports are due at the end of the financial year (30 June). Again, the nominal report

period is one year.

Report parameters

nKPI report parameters

nKPI reports have the following parameters:

* Locality Group - displays a list of all the locality groups configured on the database.
Typically select one of the following:
°<All Locality G oups> - effectively bypasses any reference to a patient’s home
address at the end of the report period. Choose this option unless a decision has
been made to exclude some patients based on where they lived at the end of the
report period. For example, health services with large numbers of frequent visitors
whose main health service is elsewhere.
° Heal th Service Area - limits the report to patients whose home address at the end of
the report period was a locality defined in this locality group. It is the health service’
s responsibility to make sure that this locality group covers the full geographical area
covered by the health service. This option will effectively exclude frequent visitors
from outside the health service area.
All other options are defined by the health service. The only times another locality group
should be chosen is for internal reporting where a health service has multiple clinics
covering different areas and for the few databases that cover more than one organisation
where each is required to report separately to the Health Data Portal.

« Patient Indicator - must be set to Al HW Regul ar d i ent, unless the report is being used for
internal reporting only and Conmuni care Current Patient status is more relevant to the
health service.

« Last Report Date - either 31st Decenber or 30th June of the relevant year. However, for
internal reporting only, interim dates can be set. Typically choose the last date of any
month rather than other dates of the month, because some indicators that look back a year

or six months to determine a currency of some data values will round to the nearest month.
There are some exceptions to the parameters presented for specific nKPI reports:

* P101 and PI02 - you cannot select a patient indicator because all children born in the
report period who have been added to the database prior to the end of the report period
are included, unless they are Fictitious or were a Non-Patient at the end of the report

period.
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« PI18 and PI119 (eGFR) - include an additional parameter of chroni ¢ Di sease to allow
the report to be generated for either Diabetes Type Il patients or Cardiovascular disease
patients. Some patients with co-morbidities will appear in both options so totalling

numbers from both must be done with care.

Note:

There are two reports for each nKPI: one contains the totals in a grid and the other lists

patient names for internal data verification and clinical action only.

OSR report parameters

OSR reports all have the following parameters:

» End of Year to Report - set to 30t h June of the relevant year. For internal reporting
purposes, any date can be selected. Typically, choose the last date of any month rather than
other dates of the month because some indicators that look back a year or six months to
determine a currency of some data values will round to the nearest month.

* Locality Group - see description above (on page 62).

Encounter place subset parameter (optional)

An optional Encounter place subset parameter is available on the nKPI reports and the OSR
reports CS-1, CS-2 and CS-3. The Encounter place subset is supported by the nKPI reports and
GRT in Specifications for National Key Performance Indicators and Online Services Reporting V16.1 and
later (July 2024).

This option is relevant for health services where only some of the encounter places need to report
nKPI or OSR data.

The Encounter place subset requires a token. Contact Telstra Health Support to configure subsets

of encounter place for reporting.

NKPI summary

Summary of NKPI reports.

Note:

This information relates to V19.0 of the Specifications for National Key Performance

Indicators and Online Services Reporting (Solving Health, Specifications for National Key
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,', Performance Indicators and Online Services Reporting V19.0. Sydney: Solving Health,

December 2025). For more information, see https://www.solvinghealth.au/specifications.

Table 10. NKPI reports

NKPI report Description Further information
PI101 Indigenous babies born within the PI 01 (on page 66)
previous 12 months whose birth
weight has been recorded Revised since the initial build
P102 Indigenous babies born within the PI 02 (on page 68)
previous 12 months whose birth . . o '
weight results were low, normal, or Revised since the initial build
high
P103 Regular clients for whom an MBS PI 03 (on page 69)
Health Assessment for Aboriginal and .
Torres Strait Islander People (MBS Revised October 2023
Item 715 or equivalent) was claimed
Pl 04 Indigenous children who are fully Retired October 2023
immunised
P1 05 Regular clients with Type Il diabetes | Pl 05 (on page 71)
who have had an HbA1lc measurement
result recorded
Pl 06 Regular clients with Type Il diabetes | Pl 06 (on page 72)
whose HbAlc measurement result was
within a specified level
P1 07 Regular clients with a chronic disease |PI 07 (on page 74)
for whom a GP Management Plan _
(MBS Item 721) was claimed Revised October 2023
P108 Regular clients with a chronic disease |Retired June 2021
for whom a Team Care Arrangement
(MBS Item 723) was claimed
P1 09 Regular clients whose smoking status | Pl 09 (on page 76)
has been recorded Communicare
Revised since the initial build
Pl 10 Regular clients with a smoking status | Pl 10 (on page 76)
result Communicare
Revised since the initial build
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Table 10. NKPI reports (continued)

NKPI report Description Further information
Pl 11 Smoking in Pregnancy PI 11 (on page 77)
Revised since the initial build
Pl1 12 Body mass index of clients PI 12 (on page 78)
Revised since the initial build
Pl 13 Regular clients who had their first Pl 13 (on page 81)
antenatal care visit
Revised since the initial build
Pl 14 Regular clients aged 6 months and Pl 14 (on page 79)
over who are immunised against
influenza Revised since the initial build
Pl 15 Regular clients with Type Il diabetes | Retired December 2021
or COPD who are immunised against
influenza
Pl 16 Regular clients whose alcohol Pl 16 (on page 81)
consumption status has been recorded
Pl 17 Regular clients who had an AUDIT-C | Retired June 2023
with result within specified levels
Pl 18 Proportion of Indigenous regular Pl 18 (on page 83)
clients with a selected chronic disease . . o .
who have a kidney function test result | Revised since the initial build
recorded.
Pl 19 Proportion of Indigenous regular Pl 19 (on page 85)
clients with a selected chronic disease
who have had a kidney function result
(eGFR and ACR) within a specified
level.
Pl 20 Regular clients who have had the PI 20 (on page 88)
necessary risk factors assessed to
enable CVD assessment
Pl 21 Regular clients aged 35 to 74 Pl 21 (on page 90)
years who have had an absolute
cardiovascular disease risk assessment
with results within specified levels
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Table 10. NKPI reports (continued)

NKPI report Description Further information

Pl 22 Regular clients who have had a Pl 22 (on page 92)
cervical screening disaggregated by _ _ o _
age groups Revised since the initial build

Pl 23 Regular clients with Type |l diabetes | Pl 23 (on page 93)
who have had a blood pressure
measurement result recorded

Pl 24 Regular clients with Type |l diabetes | Pl 24 (on page 94)
whose blood pressure measurement . . o _
result was less than or equal to Revised since the initial build
140/90 mmHg

Pl 25 Proportion of Indigenous regular Pl 25 (on page 96)
clients who have a test result for .
one or more sexually transmissible Revised October 2023
infections (STI).

Pl 26 Proportion of Indigenous regular Pl 26 (on page 98)
clients ages 0-14 years who have a
completed ear health check New October 2023
Total Number of Clients Not distributed with

Communicare at this time

PI 01 - Birthweight recorded

Proportion of Indigenous babies born within the previous 12 months whose birth weight has been

recorded.

Notes

« Birth weights are obtained from the infant's record.

« Birth weight may be recorded either in the infant's biographics or as a weight qualifier

recorded on day of birth.

« All births in last 12 months are considered whether infant was a regular client or not.

* The infant must have at least one recorded visit to the health service.
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Table 11. NKPI PI 01

Element

Description

Communicare reports

» Report > National KPI > PI01 Birth Weight Recorded
* Report > National KPI > P101 Birth Weight Recorded Patients

Numerator

A patient must have a birth weight recorded in either:

« Biographics > Birth weight
Peizonal | Social | Administiaion | Addtional |

Momes + = Sex [Femae +| Date of Bt [M1/05/2021  +| [~ Estimated Bithweight | 275 Kg

| [Forensmes |Farmdy Nasme: Prefened |Medcas [HI [Nypapau |
|#|BABY OF THERESA [ ¥ ¥ r

» Weight qualifier on any clinical item that has the same
performed date as the patient’s date of birth, suchasBirt h
details.

Birth details

Use this item to record measurements taken at birth. Record this information in the |I

(cms) and weight must be recorded in kilograms (kg). Ensure the date is changed to
Chistine Elison. Milennium Health Service (Abordginal Heakth Service) 05/05/2021 10:54:45 AM
Catnment
Date of Bith [ns/05/202 =
Height & om
Weight 275 kg

Denominator

« All patient records where the date of birth is within the report
period and who are Indigenous are included unless they were

non-patient at the end of the report period.
« Patients are excluded if their birth weight is known to be less
than 400g or their gestation at birth is known to be less than

20 weeks.
e If the birth weight and gestation at birth are both unknown

they are included.

added after the end of the report period, are fictitious or were a
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Table 11. NKPI PI 01 (continued)

Element

Description

Additional data
recording considerations

If birth weight is not recorded on the biographics form but is recorded
ontheBirth detail s clinical item, this item must have the same

date as the date of birth of the patient.

To audit incorrect dates on this item, use the report at Report >

Patients > Birth Details Audit.

This information relates to V19.0 of the Specifications for National Key Performance Indicators

and Online Services Reporting (Solving Health, Specifications for National Key Performance

Indicators and Online Services Reporting V19.0. Sydney: Solving Health, December 2025). For

more information, see https://www.solvinghealth.au/specifications.

P1 02 - Birthweight result

Proportion of Indigenous babies born within the previous 12 months whose birth weight has been

recorded

Notes

« Birth weight is categorised as one of the following:

o Low - less than 2,500 grams

o Normal - 2,500 grams to less than 4,500 grams

o High - 4,500 grams and over

« Birth weights are obtained from the infant's record.

« Birth weight may be recorded either in the infant's biographics or as a weight qualifier

recorded on the day of birth.

« All births in the last 12 months are considered, whether the infant was a regular client or

not.

¢ The infant must have at least one recorded visit to the health service.

Table 12. NKPI PI 02

Element

Description

Communicare reports

* Report > National KPI > P102 Birth Weight Categories
* Report > National KPI > P102 Birth Weight Categories Patients
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Table 12. NKPI P1 02 (continued)

Element Description

Numerator As for the numerator rules for PI01 (on page 66) but disaggregated
into the three categories of Low, Normal and High.

Denominator As for the denominator rules for PIO1 (on page 66).

Additional data As for PIO1 (on page 66).
recording considerations

This information relates to V19.0 of the Specifications for National Key Performance Indicators
and Online Services Reporting (Solving Health, Specifications for National Key Performance
Indicators and Online Services Reporting V19.0. Sydney: Solving Health, December 2025). For

more information, see https://www.solvinghealth.au/specifications.

PI 03 - Indigenous Health Assessment completed

Proportion of regular clients who received an MBS Health Assessment for Aboriginal and Torres
Strait Islander People (MBS Item 715 or any equivalent such as 228, 92004, 92016, 92011 or
92023).

Description

Proportion of Indigenous regular clients who are either:

» Aged 0-14 years and who have received an MBS Health Assessment for Aboriginal and
Torres Strait Islander People within the previous 12 months
» Aged 15 years and over and who have received an MBS Health Assessment for Aboriginal

and Torres Strait Islander People within the previous 24 months
Notes

* User may select between AIHW's definition of Regular Client (attended the OATSIH-funded
primary health care service at least 3 times in 2 years), or Communicare's Current Patient
status.

« Patients must be recorded as Aboriginal or Torres Strait Islander or both.

» A patient is deemed to have received an MBS Health Assessment if a service has the MBS

item selected for claiming, regardless of whether it has been submitted or paid.
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Table 13. NKPI PI 03

Element

Description

Communicare reports

» Report > National KPI > P103 Health Checks
» Report > National KPI > P103 Health Checks Patients

Numerator

A documented 715 (or any equivalent such as 228, 92004, 92016,
92011 or 92023) claim for a service within one year (0-14 year
olds) or two years (15+ year olds) of the end of the report period is
required. For more information, see Medicare claims (on page 36).

e Calculation A: Number of [Disaggregation: Sex] Indigenous
regular clients aged [Disaggregation: Age] who have a
current completed in-person MBS-rebated Indigenous health
assessment (MBS items: 715 or 228)

e Calculation B: Number of [Disaggregation: Sex] Indigenous
regular clients aged [Disaggregation: Age] who have a current
completed Telehealth MBS-rebated Indigenous health
assessment (MBS items: 92004, 92016)

Denominator

Regular, Indigenous patients as of the end of the report period.

e Calculation A and B: total number of [Disaggregation: Sex]
Indigenous regular clients aged [Disaggregation: Age]

Disaggregation

 Age:
> 0-4 years
o 5-14 years
o 15-24 years
o 25-34 years
° 35-44 years
° 45-54 years
o 55-64 years
° 65 years and older
e Sex:
> Male
> Female
e Type of health assessment:
° |In-person MBS-rebated Indigenous health assessment
> Telehealth MBS-rebated Indigenous health assessment
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Table 13. NKPI PI 03 (continued)

Element Description

Additional data none
recording considerations

This information relates to V19.0 of the Specifications for National Key Performance Indicators
and Online Services Reporting (Solving Health, Specifications for National Key Performance
Indicators and Online Services Reporting V19.0. Sydney: Solving Health, December 2025). For

more information, see https://www.solvinghealth.au/specifications.

Pl 05 - HbAlc recorded

Proportion of regular clients with Type Il diabetes who have had an HbAlc measurement result

recorded.

Description

Proportion of Indigenous regular clients who have either:

« Type Il diabetes and who have had an HbAlc measurement result recorded within the
previous 6 months
« Type Il diabetes and who have had an HbAlc measurement result recorded within the

previous 12 months

Notes

¢ User may select between AIHW's definition of Regular Client (attended the OATSIH-funded

primary health care service at least 3 times in 2 years), or Communicare's Current Patient
status.

« Patients must be recorded as Aboriginal or Torres Strait Islander or both.

« Only Type Il diabetes is considered (any ICPC code of T90). Type | diabetes, secondary
diabetes, gestational diabetes mellitus (GDM), previous GDM, impaired fasting glucose,
impaired glucose tolerance are not included. For more information, see System codes (on
page 34).

 Any qualifier with a system code of HBA and units of %or a system code of HBMand units
of mmol / nol is considered an HbAlc measurement. These results can be received from
an incoming pathology report or manually entered into an existing Clinical Item with a

qualifier of HbAlc. For more information, see Qualifier codes (on page 35).
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Table 14. NKPI PI 05

Element Description

Communicare reports
» Report > National KPI > PI05 Diabetes HbA1c Tests
» Report > National KPI > P105 Diabetes HbA1c Tests Patients

Numerator Any of the patients included who have a recorded HbAlc within

6 months or 12 months of the end of the report period. For more
information about codes, see Procedure, Immunisation, Pathology &
Medicare codes reference (on page 42).

Denominator Regular, Indigenous patients with a diagnosis of Type Il diabetes from
any time. For more information about codes, see Condition codes
reference (on page 36).

Additional data

recording considerations Clinicians must record HbAlc results correctly. They should not enter

a % result in the HbAlc qualifier or a mmol/mol result in the HbAlc
(%) qualifier.

Use Report > Qualifiers > With Selected Numeric values to look

for outliers such as abnormally high % values or abnormally low
mmol/mol values. For more information, see Qualifier codes (on page
35).

Mistakes should be corrected.

This information relates to V19.0 of the Specifications for National Key Performance Indicators
and Online Services Reporting (Solving Health, Specifications for National Key Performance
Indicators and Online Services Reporting V19.0. Sydney: Solving Health, December 2025). For

more information, see https://www.solvinghealth.au/specifications.

Pl 06 - HbAlc result

Proportion of regular clients with Type Il diabetes whose HbAlc measurement result was within a

specified level

Description

Number of Indigenous regular clients who have Type |l diabetes and who have had an HbAlc

measurement result recorded within the previous 6 or 12 months.
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Notes

» User may select between AIHW's definition of Regular Client (attended the OATSIH-funded

primary health care service at least 3 times in 2 years), or Communicare's Current Patient

status.

* Patients must be recorded as Aboriginal or Torres Strait Islander or both.

» Only Type Il diabetes is considered (any ICPC code of T90). Type | diabetes, secondary

diabetes, gestational diabetes mellitus (GDM), previous GDM, impaired fasting glucose,

impaired glucose tolerance are not included. For more information, see System codes (on

page 34).

 Any qualifier with a system code of HBA and units of %or a system code of HBMand units

of mmol / npl is considered an HbAlc measurement. These results can be received from

an incoming pathology report or manually entered into an existing Clinical Item with a

qualifier of HbAlc. For more information, see Qualifier codes (on page 35).

 Only the most recent HbAlc measurement result for each time period is considered.

Table 15. NKPI Pl 06

Element

Description

Communicare reports

« Report > National KPI > P106 Diabetes HbA1c Results 06
Months

* Report > National KPI > P106 Diabetes HbAlc Results 12
Months

¢ Report > National KPI > P106 Diabetes HbA1c Results Patients

Numerator

The latest HbA1c within the specified time period is used. If it was
recorded as % it is first converted to mmol/mol and rounded to
a whole number after multiplying by 10.93 and adding 23.5. The

groupings are less than or equal to 53 mmol/mol, greater than 53 and

less than or equal to 64 mmol/mol and less than 86 mmol/mol.

Denominator

Regular, Indigenous patients with a diagnosis of Type Il diabetes from

any time.
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Table 15. NKPI PI 06 (continued)

Element Description

Additional data

recording considerations Clinicians must record HbAlc results correctly. They should not enter

a % result in the HbAlc qualifier or a mmol/mol result in the HbAlc
(%) qualifier.

Use Report > Qualifiers > With Selected Numeric values to look
for outliers such as abnormally high % values or abnormally low
mmol/mol values.

Mistakes should be corrected.

This information relates to V19.0 of the Specifications for National Key Performance Indicators
and Online Services Reporting (Solving Health, Specifications for National Key Performance
Indicators and Online Services Reporting V19.0. Sydney: Solving Health, December 2025). For

more information, see https://www.solvinghealth.au/specifications.

P1 07 - Chronic Disease Management Plan prepared

Proportion of regular clients with a chronic disease who have received a GP Management Plan
(MBS Item 721 or any equivalent such as 229, 392, 965, 92024, 92068, 92055, 92099, 92029,
92060) or GP Management Plan Reviews from 1 July 2025 (MBS Item 393, 967, 92030, 92061).

Description

Proportion of Indigenous regular clients who have Type Il diabetes and who have received a GP
Management Plan (MBS Item 721 or any equivalent such as 229, 392, 965, 92024, 92068, 92055,
92099, 92029, 92060) within the previous 24 months, or GP Management Plan Reviews from 1
July 2025 (MBS Item 393, 967, 92030, 92061).

Notes

» User may select between AIHW's definition of Regular Client (attended the OATSIH-funded
primary health care service at least 3 times in 2 years), or Communicare's Current Patient
status.

* Patients must be recorded as Aboriginal or Torres Strait Islander or both.

A patient is deemed to have received a GP Management Plan if a service has the MBS item

checked for claiming, regardless of whether it has been submitted or paid.
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Table 16. NKPI PI 07

Element

Description

Communicare reports

* Report > National KPI > PI07 Diabetes GP Management Plan
* Report > National KPI > PI07 Diabetes GP Management Plan
Patients

Numerator

Currently this report looks for evidence of a 721 or any equivalent
Medicare claim. For more information, see Medicare claims (on page
36).

Denominator

Currently this indicator looks only for patients with Type Il diabetes.

Additional data
recording considerations

Health Services who are part of the Health Care Homes trial will
not be documenting care plans with a claim for item 721 or any
equivalent so will need to document these care plans with a clinical
item.

From June 2018 this indicator will also recognise a completed
procedure with an export code of CPA as being evidence of a care
plan being completed.

This information relates to V19.0 of the Specifications for National Key Performance Indicators

and Online Services Reporting (Solving Health, Specifications for National Key Performance

Indicators and Online Services Reporting V19.0. Sydney: Solving Health, December 2025). For

more information, see https://www.solvinghealth.au/specifications.

P1 09 - Smoking status recorded

Proportion of regular clients whose smoking status has been recorded.

Description

Proportion of Indigenous regular clients who have had their smoking status recorded.
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Notes

» User may select between AIHW's definition of Regular Client (attended the OATSIH-funded

primary health care service at least 3 times in 2 years), or Communicare's Current Patient

status.

* Patients must be recorded as Aboriginal or Torres Strait Islander or both.

» Patients must have had a qualifier recorded with a system code of SMOor SMP to be

included. Central qualifiers are Snoki ng st at us and Snoki ng duri ng pregnancy.

For more information, see Qualifier codes (on page 35).

Table 17. NKPI P1 09

Element

Description

Communicare reports

» Report > National KPI > PI09 Smoking Status
 Report > National KPI > PI09 Smoking Status Patients

Numerator

The latest smoking status recorded before the end of the

report period is used: there is no currency period. For details of
system codes used to identify smoking statuses, see Procedure,
Immunisation, Pathology & Medicare codes reference (on page 42).

Denominator

Regular, Indigenous patients aged 11 years and over.

Additional data
recording considerations

none

This information relates to V19.0 of the Specifications for National Key Performance Indicators

and Online Services Reporting (Solving Health, Specifications for National Key Performance

Indicators and Online Services Reporting V19.0. Sydney: Solving Health, December 2025). For

more information, see https://www.solvinghealth.au/specifications.

Pl 10 - Smoking status

Proportion of regular clients whose smoking status has been recorded.

Description

Proportion of Indigenous regular clients who have had their smoking status recorded.
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Notes

» User may select between AIHW's definition of Regular Client (attended the OATSIH-funded

primary health care service at least 3 times in 2 years), or Communicare's Current Patient

status.

* Patients must be recorded as Aboriginal or Torres Strait Islander or both.

« Patients must have had a qualifier recorded with a system code of SMOor SMP to be

included. Central qualifiers are Snoki ng st at us and Snoki ng duri ng pregnancy.

For more information, see Qualifier codes (on page 35).

Table 18. NKPI PI 10

Element

Description

Communicare reports

» Report > National KPI > PI10 Smoking Status Result
* Report > National KPI > PI10 Smoking Status Result Patients

Numerator

The latest smoking status recorded before the end of the

report period is used: there is no currency period. For details of
system codes used to identify smoking statuses, see Procedure,
Immunisation, Pathology & Medicare codes reference (on page 42).

Denominator

Regular, Indigenous patients aged 11 years and over who have had
their smoking status recorded.

Additional data
recording considerations

none

This information relates to V19.0 of the Specifications for National Key Performance Indicators

and Online Services Reporting (Solving Health, Specifications for National Key Performance

Indicators and Online Services Reporting V19.0. Sydney: Solving Health, December 2025). For

more information, see https://www.solvinghealth.au/specifications.

PI 11 - Smoking status of females who gave birth

Proportion of regular clients who have given birth in the previous 12 months whose smoking

status has been recorded.

Description

Proportion of Indigenous regular clients who have had their smoking status recorded.

77



https://www.solvinghealth.au/specifications

Notes

» User may select between AIHW's definition of Regular Client (attended the OATSIH-funded
primary health care service at least 3 times in 2 years), or Communicare's Current Patient
status.

* Patients must be recorded as Aboriginal or Torres Strait Islander or both.

» Patients must have had a qualifier recorded with a system code of SMOor SMP to be
included. Central qualifiers are Snoki ng st at us and Snoki ng duri ng pregnancy.

For more information, see Qualifier codes (on page 35).

Table 19. NKPI PI 11

Element Description

Communicare reports
e Report > National KPI > PI11 Smoking in Pregnancy
 Report > National KPI > PI11 Smoking in Pregnancy Patients

Numerator The latest smoking status recorded before the end of the report
period is used: there is no currency period.

Denominator Regular, Indigenous patients aged 11 years and over who have had
their smoking status recorded.

Additional data none
recording considerations

This information relates to V19.0 of the Specifications for National Key Performance Indicators
and Online Services Reporting (Solving Health, Specifications for National Key Performance
Indicators and Online Services Reporting V19.0. Sydney: Solving Health, December 2025). For

more information, see https://www.solvinghealth.au/specifications.

Pl 12 - Body mass index of clients

Proportion of Indigenous regular clients who have a Body Mass Index (BMI) result within specified

categories.

Description

Proportion of regular clients who are Indigenous, aged 18 and over who have had their body mass

index (BMI) classified as one of the following in the previous 24 months:

» Underweight (<18.50)
* Normal weight (>=18.50 but <25)
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« Overweight (>=25 but <30)

* Obese (>=30)

If there is no BMI recorded or it was recorded more than 24 months ago, the BMI is classified as

Not cal cul at ed.

Notes

e The user may choose either AIHW's definition of Regular Client (attended the OATSIH-

funded primary health care service at least 3 times in 2 years), or Communicare’s Current

Patient status.

« Patients must be recorded as Aboriginal or Torres Strait Islander or both.

* Only the most recent measurement result with a system code of BMI in the previous 24

months is considered.

Table 20. NKPI Pl 12

Element

Description

Communicare reports

« Report > National KPI > PI12 Overweight
» Report > National KPI > PI12 Overweight Patients

Numerator

This report looks only for recorded BMls, it does not calculate BMIs
based on weight, height and age.

Denominator

Regular, Indigenous patients with a BMI recorded.

Additional data
recording considerations

Health services should encourage the recording of BMIs for all
patients.

This information relates to V19.0 of the Specifications for National Key Performance Indicators
and Online Services Reporting (Solving Health, Specifications for National Key Performance
Indicators and Online Services Reporting V19.0. Sydney: Solving Health, December 2025). For

more information, see https://www.solvinghealth.au/specifications.

Pl 13 - First Antenatal Visit

Proportion of regular female clients who received antenatal care within specified periods.
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Notes

» User may select between AIHW's definition of Regular Client (attended the OATSIH-funded
primary health care service at least 3 times in 2 years), or Communicare's Current Patient
status.

* Patients must be recorded as Aboriginal or Torres Strait Islander or both.

« Any clinical item with a system code of PRE and a rule code of PR- CHECK can be used. For
more information, see System codes (on page 34).

« Although the category of No resul t is included as part of the specifications, the additional
category of (No known antenatal care) is specifically to report on patients where, in
Communicare, the clinical item No known ant enatal care has been recorded, and there is no
prior or subsequent antenatal activity recorded.

* Percentages may not add up to 100%.

Table 21. NKPI Pl 13

Element Description

Communicare reports
» Report > National KPI > PI13 Antenatal Care
» Report > National KPI > PI13 Antenatal Care Patients

Numerator For details of how to recognise an antenatal check, see Procedure,
Immunisation, Pathology & Medicare codes reference (on page 42).

» Always record the gestation at the time of recording an
antenatal check.

 Antenatal checks recorded must have the same number as the
pregnancy outcome to be included.

 Performed date and pregnancy number must be completed.

Denominator Women who have given birth in the report period.

Additional data
. . . (g A
recording considerations Note:

Ensure that both the gestation of the pregnancy outcome
and the date of delivery are recorded. Without these two
data, the earliest antenatal check may not be recognised
unless it has the gestation explicitly recorded at that time.
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This information relates to V19.0 of the Specifications for National Key Performance Indicators
and Online Services Reporting (Solving Health, Specifications for National Key Performance
Indicators and Online Services Reporting V19.0. Sydney: Solving Health, December 2025). For

more information, see https://www.solvinghealth.au/specifications.

Pl 14 - Clients who are immunised against influenza

Proportion of Indigenous patients aged 6 months and over who are immunised against influenza.

Notes

» User may select between AIHW's definition of Regular Client (attended the OATSIH-funded
primary health care service at least 3 times in 2 years), or Communicare's Current Patient
status.

« Patients must be recorded as Aboriginal or Torres Strait Islander or both.

Table 22. NKPI Pl 14

Element Description

Communicare reports
* Report > National KPI > PI14 Influenza Immunisations
* Report > National KPI > P114 Influenza Immunisations Patients

Numerator For more information, see Export codes (on page 35). For details
of influenza clinical item export codes, see Procedure, Immunisation,
Pathology & Medicare codes reference (on page 42).

Denominator Regular, Indigenous patients aged 6 months and over at the end of
the report period.

Additional data This report relies on valid AIR codes for influenza vaccines being
recording considerations | recorded as the export code for such immunisation types. New codes
may be introduced with each season.

This information relates to V19.0 of the Specifications for National Key Performance Indicators
and Online Services Reporting (Solving Health, Specifications for National Key Performance
Indicators and Online Services Reporting V19.0. Sydney: Solving Health, December 2025). For
more information, see https://www.solvinghealth.au/specifications.

Pl 16 - Alcohol consumption recorded

Proportion of regular clients whose alcohol consumption status has been recorded.

81


https://www.solvinghealth.au/specifications
https://www.solvinghealth.au/specifications

Description

Proportion of Indigenous regular clients aged 15 years and over where their health provider has
recorded:

* Whether the client consumes alcohol

* The amount and frequency of the client's alcohol consumption

Notes

» User may select between AIHW's definition of Regular Client (attended the OATSIH-funded
primary health care service at least 3 times in 2 years), or Communicare's Current Patient
status.

« Patients must be recorded as Aboriginal or Torres Strait Islander or both.

« Patients must have had a qualifier with a system code of ALC or ALPrecorded to be
included

o Central qualifiers are Al cohol Consunption Level and Al cohol
Consunpti on During Pregnancy.

o Example clinical items include Check up; Abori gi nal & TSI adul t,Check
up; ant enat al

o Alternatively, in the AUDI T- Cassessment (Check up; al cohol ; AUDI T- C), they

may have at least the first two qualifiers recorded, or an AUDIT-C score or a full
AUDIT score.

Table 23. NKPI Pl 16

Element Description

Communicare reports
» Report > National KPI > PI116 Alcohol Status
» Report > National KPI > P116 Alcohol Status Patients

Numerator This report looks for any evidence in the previous two years of either
alcohol consumption level, or an AUDIT-C score or a full AUDIT
score or both question 1 and question 2 of the AUDIT C/AUDIT being
recorded at the same time.

Denominator Regular, Indigenous patients.

Additional data none
recording considerations
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This information relates to V19.0 of the Specifications for National Key Performance Indicators
and Online Services Reporting (Solving Health, Specifications for National Key Performance
Indicators and Online Services Reporting V19.0. Sydney: Solving Health, December 2025). For

more information, see https://www.solvinghealth.au/specifications.

Pl 18 - Kidney Function Testing

Proportion of Indigenous regular clients with a selected chronic disease who have a selected

kidney function test result recorded.

Description

Proportion of regular clients who are Indigenous aged 18 years and over, who are recorded as

having one of the following:

 Type 2 diabetes
« Cardiovascular disease (CVD)
 Type 2 diabetes and/or CVD

and who have also had one of the following:

* An estimated glomerular filtration rate (eGFR) and an albumin/creatinine ratio (ACR) test
result recorded

* Only an eGFR test result recorded

* Only an ACR test result recorded

* Neither an eGFR nor an ACR test result recorded
within the previous 12 months.
Notes

» User may select between AIHW's definition of Regular Client (attended the OATSIH-funded
primary health care service at least 3 times in 2 years), or Communicare's Current Patient
status.

« Patients must be recorded as Aboriginal or Torres Strait Islander or both.

» ACR results are identified as belonging to a qualifier with the system code of ACR and
eGFR results are identified as belonging to a qualifier with the system code of GFE. Both
laboratory and manually entered results are included. For more information, see System

codes (on page 34).
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Table 24. NKPI PI 18

Element

Description

Communicare reports

 Report > National KPI > PI118 Kidney Function
 Report > National KPI > PI18 Kidney Function Patients

Numerator

ACR and eGFR results must be within 12 months of the end of the
report period. Both CVD and diabetes patients are disaggregated by
whether or not they have both an eGFR,and ACR, or neither.

Denominator

Regular, Indigenous patients aged 18 years and over at the end of the
report period with Type 2 diabetes or CVD.

For more information about condition codes, see Condition codes
reference (on page 36).

Disaggregation

* Age
o 18-24 years
o 25-34 years
° 35-44 years
° 45-54 years
> 55-64 years
° 65 years and older
e Sex
> Male
° Female
e Chronic disease
> Type 2 diabetes
° Cardiovascular disease
> Either or both of the above
e Test
> an eGFR only
> an ACR only
° both an eGFR and an ACR
° neither an eGFR nor an ACR
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Table 24. NKPI PI 18 (continued)

Element Description

Additional data

recording considerations » Type 2 diabetes - specifically excludes Type | diabetes,
secondary diabetes, gestational diabetes mellitus (GDM),
previous GDM, Impaired fasting glucose, and impaired glucose
tolerance

¢ ACR - refers to an albumin/creatinine ratio

e an eGFR only - a recorded eGFR result, where an ACR result
HAS NOT been recorded

e an ACR only - a recorded ACR result, where an eGFR result
HAS NOT been recorded

e both an eGFR and an ACR - a recorded eGFR result AND a
recorded ACR result

 neither an eGFR NOR an ACR - an eGFR result AND an ACR
result HAS NOT been recorded

* Negative ACR and eGFR values are reported as not recorded

This information relates to V19.0 of the Specifications for National Key Performance Indicators
and Online Services Reporting (Solving Health, Specifications for National Key Performance
Indicators and Online Services Reporting V19.0. Sydney: Solving Health, December 2025). For

more information, see https://www.solvinghealth.au/specifications.

Pl 19 - Kidney function test result

Proportion of First Nations regular clients with a selected chronic disease who have had a kidney

function test result (eGFR and ACR) within a specified category.

Description

Proportion of regular clients who are Indigenous aged 18 years and over, who are recorded as

having one of the following:

» Type 2 diabetes
« Cardiovascular disease (CVD)
 Type 2 diabetes and/or CVD

whose estimated glomerular filtration rate (eGFR) AND albumin/creatinine ratio (ACR) recorded

within the previous 12 months were categorised as:
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* Normal risk

e Low risk

« Moderate risk
 High risk

Table 25. eGFR & ACR risk categories

Risk level Description
Normal risk eGFR >60 mL/min/1.73m? AND ACR <3.0 mg/mmol
Low risk Either:

e eGFR =45 mL/min/1.73m? and <60 mL/min/1.73m? AND ACR <3.0
mg/mmol, OR

» eGFR >60 mL/min/1.73m? AND ACR >3.0 mg/mmol and <30
mg/mmol

Moderate risk Either:

e eGFR 245 mL/min/1.73m? and <60 mL/min/1.73m? AND ACR >3.0
mg/mmol and <30 mg/mmol, OR

* eGFR >30 mL/min/1.73m? and <45 mL/min/1.73m2 AND ACR <30
mg/mmol

High risk Either:

e eGFR =30 mL/min/1.73m? AND ACR >30ml/mmol, OR
» eGFR <30 mL/min/1.73m? AND any ACR result

Notes

» User may select between AIHW's definition of Regular Client (attended the OATSIH-funded
primary health care service at least 3 times in 2 years), or Communicare's Current Patient
status.

« Patients must be recorded as Aboriginal or Torres Strait Islander or both.
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Table 26. NKPI PI 19

Element

Description

Communicare reports

» Report > National KPI > PI119 Kidney Function Results Patients
* Report > National KPI > PI119 Kidney Function Results

Numerator

The number of [Disaggregation: Sex] First Nations regular clients with
[Disaggregation: Chronic disease] aged [Disaggregation: Age] whose
most recent eGFR and ACR results, recorded within the previous 12
months, were [Disaggregation: Risk category]

Note:

This is equivalent to calculation A to L on METEOR

Denominator

Total number of [Disaggregation: Sex] First Nations regular clients
with [Disaggregation: Chronic disease] aged [Disaggregation: Age]
who had both eGFR and ACR results recorded within the previous 12
months

Disaggregation

e Age
> 18 to less than 25 years
> 25 to less than 35 years
° 35 to less than 45 years
° 45 to less than 55 years
> 55 to less than 65 years
° 65 years and older
e Sex
> Male
> Female
e Chronic disease
> Type 2 diabetes
° Cardiovascular disease
° Either or both of the above
* Risk, see Table 25: eGFR & ACR risk categories (on page 86).
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Table 26. NKPI PI 19 (continued)

Element Description

Counting rules Inclusion Criteria

» Have type 2 diabetes and/or CVD
e A valid eGFR AND a valid ACR test recorded within the previous
12 months

Exclusion Criteria

« Type 1 diabetes, secondary diabetes, gestational diabetes
mellitus (GDM),previous GDM, impaired fasting glucose, and
impaired glucose tolerance

e Invalid test results (i.e. negative, non-numerical and null
values)

Additional data
recording considerations e Count is of people, not tests
e Count only the most recent eGFR and ACR tests
¢ 'ACR' definition: albumin/creatinine ratio
« Valid test result recorded: a numeric value that can be used to
classify test results into the risk categories specified in ‘Chronic
Kidney Disease (CKD) Management in Primary Care’ guidelines
e Chronic disease patient counts:
> Type 2 diabetes: have type 2 diabetes irrespective of
CVD status
> CVD: have CVD irrespective of type 2 diabetes status
> Type 2 diabetes and/or CVD: have diabetes only OR have
CVD only OR have type 2 diabetes AND CVD

This information relates to V19.0 of the Specifications for National Key Performance Indicators
and Online Services Reporting (Solving Health, Specifications for National Key Performance
Indicators and Online Services Reporting V19.0. Sydney: Solving Health, December 2025). For

more information, see https://www.solvinghealth.au/specifications.

Pl 20 - CVD risk assessment factors

Proportion of regular clients who have had the necessary risk factors assessed to enable

cardiovascular disease (CVD) assessment
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Description

Proportion of Indigenous regular clients with no known cardiovascular disease (CVD), assessed

aged 35 to 74, with information available to calculate their absolute CVD risk.

Notes

» User may select between AIHW's definition of Regular Client (attended the OATSIH-funded
primary health care service at least 3 times in 2 years), or Communicare's Current Patient
status.

« Patients must be recorded as Aboriginal or Torres Strait Islander or both.

« Patients must have a sex and date of birth.

« Patients must have the following recorded in the previous 24 months:

o Smoking status (reference qualifier with system code of SMOor SMP).

o Systolic blood pressure (numeric qualifier with system code of BPS).

o Either total cholesterol and HDL (numeric qualifiers with system codes of CHOand
HDL) or cholesterol/HDL level (numeric qualifier with system code of CHR).

o For more information about qualifier system codes, see Qualifier codes (on page
35).

Table 27. NKPI PI 20

Element Description

Communicare reports
* Report > National KPI > PI120 CVD Risk Factors
* Report > National KPI > P120 CVD Risk Factors Patients

Numerator All defined measures must have been recorded in the previous two
years.
Denominator Regular, Indigenous patients aged 35 years and under 75 years old at

the end of the report period without a CVD diagnosis.

For more information about condition codes, see Condition codes
reference (on page 36).
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Table 27. NKPI PI 20 (continued)

Element Description

Additional data
, . . ( )
recording considerations Note:

some patients will not have all the measures recorded, but
will still have an absolute CV risk recorded for indicator Pl 21
(on page 90). This may be a data entry issue or may relate

to some patients who can have a high risk inferred due to
age and other conditions. For example, over 60 years with
diabetes and microalbuminuria.

This information relates to V19.0 of the Specifications for National Key Performance Indicators
and Online Services Reporting (Solving Health, Specifications for National Key Performance
Indicators and Online Services Reporting V19.0. Sydney: Solving Health, December 2025). For

more information, see https://www.solvinghealth.au/specifications.

Pl 21 - CVD risk assessment result

Proportion of regular clients aged 35 to 74 years who have had an absolute cardiovascular disease

(CVD) risk assessment with results within specified levels.

Description

Proportion of Indigenous regular clients, aged 35 to 74 and with no known history of
cardiovascular disease (CVD), who have had an absolute CVD risk assessment recorded within the

previous 24 months and whose CVD risk was categorised as one of the following:

» High (greater than 15% chance of a cardiovascular event in the next 5 years)
* Moderate (10-15% chance of a cardiovascular event in the next 5 years)

 Low (less than 10% chance of a cardiovascular event in the next 5 years)
Notes

» User may select between AIHW's definition of Regular Client (attended the OATSIH-funded
primary health care service at least 3 times in 2 years), or Communicare's Current Patient
status.

* Patients must be recorded as Aboriginal or Torres Strait Islander or both.

« Patients must have a sex and date of birth.
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« Patients must have a record of their cardiovascular risk (high, moderate or low) recorded
within the previous 24 months. For the purpose of this report the cardiovascular risk needs
to be recorded as a reference type qualifier or a numeric type qualifier with appropriate
export or system codes:

o For CARPA STM guidelines used by the NT for NKPI reporting, either of the following:
= Reference type qualifier with an export code of CVR- RO5C and dropdown
references with system codes of H, Mor L (for high, moderate or low)

» Numeric type qualifier with units of % and an export code of CVR- NO5C

o ™
Note:

CARPA STM results will be adjusted for Aboriginal patients to remove the

5% loading and Aboriginal patients aged between 20 and 34 years are not

included in this report.
- J

o For Framingham calculations, used by all states other than the NT, either of the
following:
= Reference type qualifier with an export code of CVR- RO5F and dropdown
references with system codes of H, Mor L (for high, moderate or low)
= Numeric type qualifier with units of % and an export code of CVR- NO5F
> The CVD Ri sk Cal cul at or (AusCVDRi sk) clinical item, used to capture the
output of the online AUSCVDRisk calculator for the patient’s record, is not currently

used for NKPI reporting.

Table 28. NKPI PI 21

Element Description

Communicare reports
« Report > National KPI > PI121 CVD Risk
» Report > National KPI > PI21 CVD Risk Patients

Numerator For export codes used, see Qualifiers reference (on page 47).

Denominator
Regular, Indigenous patients aged 35 years and under 75 years old at

the end of the report period with a CV risk assessment but without a
CVD diagnosis.

For more information about condition codes, see CVD condition
codes (on page 38).
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Table 28. NKPI PI 21 (continued)

Element Description

Additional data Health services should determine if they are going to use the
recording considerations | Framingham or CARPA calculator distributed with Communicare
and consider disabling the one they do not use. This report will use
Framingham scores as they are recorded but will remove the 5%
loading that the CARPA calculation does for Indigenous patients
before reporting. Also, see comments for Pl 20 (on page 88).

This information relates to V19.0 of the Specifications for National Key Performance Indicators
and Online Services Reporting (Solving Health, Specifications for National Key Performance
Indicators and Online Services Reporting V19.0. Sydney: Solving Health, December 2025). For

more information, see https://www.solvinghealth.au/specifications.

Pl 22 - Female clients who have had a cervical screening (HPV) test

Proportion of female Indigenous regular clients who have had a cervical screening (HPV) test

Description

Proportion of female Indigenous regular clients aged 25-74, who have not had a hysterectomy
and who have had a cervical screening (human papillomavirus (HPV)) test within the previous 5

years where the test occurred on or after 1 December 2017.
Notes

» User may select between AIHW's definition of Regular Client (attended the OATSIH-funded
primary health care service at least 3 times in 2 years), or Communicare's Current Patient
status.

* Patients must be recorded as Aboriginal or Torres Strait Islander or both.

« A cervical screening result is any incoming electronic pathology result identified as being
a cervical screening where its laboratory description contains CST, HPV, LBC, CERVICAL
SCREEN, GYNAECOLOGICAL CYTOLOGY or NCSP.

* A cervical screening clinical item is a completed item of any class with the export code of
CST, HPV or LBC.

A cervical screening qualifier is any qualifier which is a Yes/No qualifier with the export

code of CST, HPV or LBC where the response recorded was Yes.
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Table 29. NKPI PI 22

Element Description

Communicare reports
 Report > National KPI > P122 Cervical Screening
» Report > National KPI > P122 Cervical Screening Patients

Numerator For details of how evidence of a cervical screening is determined, see
Procedure, Immunisation, Pathology & Medicare codes reference (on
page 42).

Denominator Regular, Indigenous women aged 25 years and above to less than 75
years.

Additional data none

recording considerations

This information relates to V19.0 of the Specifications for National Key Performance Indicators
and Online Services Reporting (Solving Health, Specifications for National Key Performance
Indicators and Online Services Reporting V19.0. Sydney: Solving Health, December 2025). For

more information, see https://www.solvinghealth.au/specifications.

Pl 23 - Blood Pressure recorded

Proportion of regular clients with Type 2 diabetes who have had a blood pressure measurement

result recorded.

Description

Proportion of regular clients who are Indigenous, have Type 2 diabetes and who have had a blood
pressure measurement result recorded at the primary health care service within the previous 6

months.
Notes

« User may select between AIHW's definition of Regular Client (attended the OATSIH-funded
primary health care service at least 3 times in 2 years), or Communicare's Current Patient
status.

« Patients must be recorded as Aboriginal or Torres Strait Islander or both.

« Only Type Il diabetes is considered (any ICPC code of T90). Type | diabetes, secondary

diabetes, gestational diabetes mellitus (GDM), previous GDM, impaired fasting glucose,
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impaired glucose tolerance are not included. For more information, see System codes (on

page 34).

« Any qualifier with a system code of BPS or BPD is considered a systolic or diastolic blood

pressure measurement. For more information, see Qualifier codes (on page 35).

Table 30. NKPI PI 23

Element

Description

Communicare reports

» Report > National KPI > PI123 Diabetes BP Tests
« Report > National KPI > P123 Diabetes BP Tests Patients

Numerator

Both diastolic and systolic blood pressure must be recorded at the
same time.

Denominator

Regular, Indigenous patients with a diagnosis of Type Il diabetes from
any time.

For more information about condition codes, see Condition codes
reference (on page 36).

Additional data
recording considerations

- N
Note:
Local clinical items should not contain more than one
qualifier with the system code of BPS and one with the
system code of BPD as this is not currently supported and

may lead to anomalies in both Pl 23 and PI24.
- /

For more information, see Qualifier codes (on page 35).

This information relates to V19.0 of the Specifications for National Key Performance Indicators

and Online Services Reporting (Solving Health, Specifications for National Key Performance

Indicators and Online Services Reporting V19.0. Sydney: Solving Health, December 2025). For

more information, see https://www.solvinghealth.au/specifications.

Pl 24 - Blood Pressure result

Proportion of Indigenous regular clients with Type 2 diabetes whose blood pressure measurement

result was within specified categories
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Description

Proportion of regular clients who are Indigenous, have Type 2 diabetes and whose blood pressure

measurement result, recorded within the previous 6 months, was less than or equal to 140/90

mmHg.

Notes

« User may select between AIHW's definition of Regular Client (attended the OATSIH-funded

primary health care service at least 3 times in 2 years), or Communicare's Current Patient

status.

» Patients must be recorded as Aboriginal or Torres Strait Islander or both.

« Only Type Il diabetes is considered (any ICPC code of T90). Type | diabetes, secondary

diabetes, gestational diabetes mellitus (GDM), previous GDM, impaired fasting glucose,

impaired glucose tolerance are not included. For more information, see System codes (on

page 34).

* The patient does not have a blood pressure measurement of less than or equal to 140/90

mmHg if either the systolic or diastolic reading is above the threshold (140 and 90

respectively).

» Only the most recent blood pressure measurement result in previous 6 months is

considered.

Table 31. NKPI Pl 24

Element

Description

Communicare reports

* Report > National KPI > PI24 Diabetes BP Results
* Report > National KPI > P124 Diabetes BP Results Patients

Numerator

Both diastolic and systolic blood pressure must be recorded at the
same time.

A blood pressure is deemed to be low if the systolic value is 140 or
less and the diastolic value is 90 or less.

Denominator

Regular, Indigenous patients with a diagnosis of Type Il diabetes from
any time who have a blood pressure recorded.

For more information about condition codes, see Condition codes
reference (on page 36).
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Table 31. NKPI Pl 24 (continued)

Element Description

Additional data
, . . ( )
recording considerations Note:

Local clinical items should not contain more than one
qualifier with the system code of BPS and one with the
system code of BPD as this is not currently supported and

may lead to anomalies in both Pl 23 and PI24.
N J

For more information, see Qualifier codes (on page 35).

This information relates to V19.0 of the Specifications for National Key Performance Indicators
and Online Services Reporting (Solving Health, Specifications for National Key Performance
Indicators and Online Services Reporting V19.0. Sydney: Solving Health, December 2025). For

more information, see https://www.solvinghealth.au/specifications.

Pl 25 - STI result recorded

Proportion of Indigenous regular clients who have a test result for one or more sexually

transmissible infections (STI).

Description

Proportion of Indigenous patients aged 15 to 34 years who had an STI result recorded within the

previous 12 months for:

» Chlamydia
* Gonorrhoea

» Chlamydia and gonorrhoea
Notes

» User may select between AIHW's definition of Regular Client (attended the OATSIH-funded
primary health care service at least 3 times in 2 years), or Communicare's Current Patient
status.

* Patients must be recorded as Aboriginal or Torres Strait Islander or both.

» Patients deceased at the end of the reporting period are not included.

e An STl result is:
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> Any incoming electronic pathology result identified as being a chlamydia or
gonorrhoea test by known LOINCs. Where no LOINC is returned by the lab, the test
name is parsed for a small set of keywords but also excludes some chlamydia results
based on exclusion terms. See the specifications referenced below and refer to Appendix
F - STI Coding framework for details.

> Any reference type qualifier defined with an export code of CT- RSLT (indicating
a chlamydia result has been received) or NG RSLT (indicating a gonorrhoea result
has been received). In addition, the TTANGO qualifiers of TTANGO Chl anydi a and
TTANGO Gonnor r hoea are accepted. The export codes should be attached to any

existing local qualifiers currently used to record POC STI testing.

Table 32. NKPI PI 25

Element Description

Communicare reports
» Report > National KPI > PI125 STI Results Patients
» Report > National KPI > PI125 STI Results

Numerator The number of regular clients aged 15-34 years who have had a
chlamydia and/or gonorrhoea test result recorded within the previous
12 months.

Denominator The number of regular, Indigenous patients aged 15-34 years at the

end of the report period

Disaggregation
e Age
° 15-19 years
o 20-24 years
o 25-29 years
° 30-34 years
e Sex
> Male
> Female

Additional data -
recording considerations

This information relates to V19.0 of the Specifications for National Key Performance Indicators
and Online Services Reporting (Solving Health, Specifications for National Key Performance
Indicators and Online Services Reporting V19.0. Sydney: Solving Health, December 2025). For

more information, see https://www.solvinghealth.au/specifications.
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Pl 26 - Ear Health Check

Proportion of Indigenous regular clients ages 0-14 years who have a completed ear health check

recorded.

Description

Proportion of Indigenous regular clients who, in the previous 12 months, have had a completed

check that was recorded, of the:

 Appearance of both ear canals and eardrums
¢ Movement of both eardrums

» Appearance of both ear canals and ear drums and movement of both ear drums

Both ears should be checked; however, if a person has only one ear, only one ear can be checked.
If there is detail in the patient record specific to only the left or right ear the patient will still be

included in the relevant measure code.

Notes

o M
Note:
New system and export codes have been added to relevant central qualifiers in
Communicare to support recording data for this Pl. Communicare Administrators should
assess whether their local qualifiers need to similarly be updated. For more information,

see Codes to support nKPI Pl 26 Ear Health Checks (on page 103).
- /

» User may select between AIHW's definition of Regular Client (attended the OATSIH-funded
primary health care service at least 3 times in 2 years), or Communicare's Current Patient
status.

* Patients must be recorded as Aboriginal or Torres Strait Islander or both.

« Patients deceased at the end of the reporting period are not included.

Table 33. NKPI Pl 26

Element Description

Communicare reports
* Report > National KPI > P126 Ear Health Checks Patients

» Report > National KPI > P126 Ear Health Checks

98 GRT & nKPI Reference Guide



Table 33. NKPI Pl 26 (continued)

Element Description

Numerator

« Calculation A: number of Indigenous regular clients aged
[Disaggregation: Age] who have had a completed check of
the appearance of both ear canals and ear drums within the
previous 12 months.

e Calculation B: number of [Disaggregation: Gender] Indigenous
regular clients aged [Disaggregation: AgeJwho have had a
completed check of the movement of both eardrums within the
previous 12 months.

e Calculation C: number of [Disaggregation: Gender] Indigenous
regular clients aged [Disaggregation: AgeJwho have had a
completed check of the appearance of both ear canals and
eardrums and the movement of both eardrums within the
previous 12 months.

Denominator Calculation A, B and C: total number of [Disaggregation: Gender]
Indigenous regular clients aged [Disaggregation: Age].

Disaggregation
e Age
° 0-11 months
° 12-23 months
° 24-35 months
° 36-59 months
> 5-9 years
° 10-14 years
e Gender
> Male
> Female

Additional data -
recording considerations

This information relates to V19.0 of the Specifications for National Key Performance Indicators
and Online Services Reporting (Solving Health, Specifications for National Key Performance
Indicators and Online Services Reporting V19.0. Sydney: Solving Health, December 2025). For

more information, see https://www.solvinghealth.au/specifications.
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Ear Health Check Included Clinical Items and Qualifiers

Use these Central clinical items for ear health conditions or procedures to capture evidence of
an appearance or movement check to include in nKPI and NT KPI reporting for Pl 26 Ear Health
Checks.

Table 34. Ear Health Check Clinical Items

Group Clinical Item Code’ C::;Zar::z::::
Otitis externa Otitis externa H70002 Both
Swimmers ear H70003
Otitis media Effusion;middle ear H72001 Both
Glue ear H72002
Otitis media H71003
Otitis media (with);effusion H72005
Otitis media;acute H71002
Otitis media;acute;no perforat H71020
Otitis media;acute;perforation H71021
Otitis media;chronic H74004
Otitis media;nonsuppurative H72003
Otitis media;perforated H71004
Otitis media;serous H72004
Otitis media;suppurative;acute H71009
Otitis media;suppurative;chron H74006
Myringitis Myringitis H71001 Appearance
Myringitis;chronic H74002
Inflammation;tympanic membra H71006
Tympanitis H71005
Perforation of tympanic | Perforation;ear drum H77002 Appearance
membrane Perforation;tympanic membran H77001
Rupture(trauma/pres); eardrum H79003
Cholesteatoma Cholesteatoma H74005 Appearance

1. The code is a combination of the ICPC-2 PLUS Code and Term values.
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Table 34. Ear Health Check Clinical Items (continued)

Group Clinical Item Code’ Cz;eear:ta:::::::
Otorrhoea Discharge;ear H04001 Appearance
Pus (from);ear H04002
Bleeding from Ear Bleeding;ear HO5001 Appearance
Procedure Endoscopy;diagnostic;ear H40001 Appearance
Test;tympanometry H39007 Movement
Check up;complete;ear H30001 Both
Exam;complete;ear B H30002
Assessment;complete;hearing H30003
Myringotomy H51010
Grommet(s) H53003
Drainage tube(s);middle ear H53004
Myringoplasty H54006
Tympanoplasty H54007
Otorrhoea;tympanostomy tube H72007
Table 35. Central Qualifiers used in PI26
Sys Code Name Number M Type Export Code
L Drawing:eardrum | 1000003176 W) OTO-NKPI
(L tympanic
membrane)
L Ear exam: left 1000000945 (R) OTO-NKPI
L Ear exam: left 1000000944 )] OTO-NKPI
comments/action
L Otoscope image | 1000003404 )] OTO-NKPI
left ear
L Otoscopy - Left | 1000000277 (T OTOSCOPY
L Otoscopy Lleft ear | 1000000217 (R) OTOSCOPY
L Tympanometry - | 1000000295 (N) TYM-NKPI
L Canal Vol

1.

The code is a combination of the ICPC-2 PLUS Code and Term values.
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Table 35. Central Qualifiers used in P126 (continued)

Sys Code Name Number M Type Export Code

L Tympanometry - | 1000000301 (R) TYM-NKPI
L Category

L Tympanometry - | 1000000297 (N) TYM-NKPI
L Compliance

L Tympanometry - | 1000000299 (N) TYM-NKPI
L Pressure

L Tympanometry 1000003247 (R) TYM-NKPI
-Lear-
interpretation

L Tympanometry - | 1000002059 (R) TYM-NKPI
left

LR Drawing:eardrum | 1000001649 W) OTO-NKPI
(L, R tympanic
membrane)

LR Tympanometry 1000003403 (M) TYM-NKPI
notes

R Drawing:eardrum | 1000003175 W) OTO-NKPI
(R tympanic
membrane)

R Ear exam:right 1000000947 (R) OTO-NKPI

R Ear exam: right 1000000946 ) OTO-NKPI
comments/action

R Otoscope image | 1000003405 (1 OTO-NKPI
right ear

R Otoscopy - Right | 1000000278 (M OTOSCOPY

R Otoscopy right 1000000218 (R) OTOSCOPY
ear

R Tympanometry - | 1000000296 (N) TYM-NKPI
R Canal Vol

R Tympanometry - | 1000000302 (R) TYM-NKPI
R Category

R Tympanometry - | 1000000298 (N) TYM-NKPI
R Compliance
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Table 35. Central Qualifiers used in PI26 (continued)

Sys Code Name Number M Type Export Code
R Tympanometry - | 1000000300 (N) TYM-NKPI
R Pressure
R Tympanometry 1000003246 (R) TYM-NKPI
-Rear -
interpretation
R Tympanometry - | 1000002058 (R) TYM-NKPI
right
g ™
0 Tip:
To help understand which qualifiers used at your health service use the relevant export
and system codes for nKPI and NT KPI reporting for Pl 26 Ear Health Checks, generate a
list of all qualifiers; run Report > Reference Tables > System Codes and Rule Codes.
- J

Codes to support nKPI PI 26 Ear Health Checks

Add export and system codes to any qualifiers used in local clinical items that you want to use to

capture evidence of an appearance or movement check to include in nKPI and NT AHKPI reporting
for Pl 26 Ear Health Checks.

For a list of Central qualifiers included in P126 reports, see Ear Health Check Included Clinical

Items and Qualifiers (on page 100).

To include local qualifiers in nKPI or NT KPI reporting, in File > Reference Tables > Qualifier Types:

1. For nKPIs, identify a qualifier as an appearance check by adding either the export code of

OTO NKPI or orascory. The nKPI P126 includes both oro NkPI and OTOSCORY.

N

a ™
0 Tip:
If the qualifier should be included in the NT AHKPI indicator 1-20 Ear Disease in
Children, use the export code of orascopy only. For more information, see NT
AHKPIs (on page 127).
J

2. ldentify a qualifier as a movement check by adding the export code of TYM NKPI

3. ldentify each of the appearance or movement checks with a system code of L, Ror LRto

identify that the qualifier check covers either the left or right or both ears.

103




4. Add options for each qualifier that record that a check was not done with a system code
of 0. All other options that record that a check was performed satisfactorily should have
a system code of 1. If there is no system code recorded it is assumed that the check was

done.

OSR summary

Summary of Online Services Report (OSR) data collection.

o M
Note:
This information relates to V19.0 of the Specifications for National Key Performance
Indicators and Online Services Reporting (Solving Health, Specifications for National Key
Performance Indicators and Online Services Reporting V19.0. Sydney: Solving Health,

December 2025). For more information, see https://www.solvinghealth.au/specifications.
. J

The OSR collects national data about organisations which receive funding from the Indigenous
Australians’ Health Programme (IAHP) to deliver health services to Aboriginal and Torres Strait

Islander people. These services include primary health care, maternal and child health care.

The OSR dataset focuses on the characteristics of these services, along with the activities and
services they provide. It provides a basic measure of activity, volume and coverage of services. It
does not collect information on Indigenous health outcomes, which is collected in the National
Key Performance Indicators (nKPIs). For more information, see https://www.health.gov.au/topics/

aboriginal-and-torres-strait-islander-health/reporting/osr.

Table 36. Summary of OSR reports

OSR report Description Further information

OSR CS-1 How many episodes of health CS-1 (on page 106)
care were provided by your
health service during year?

OSR CS-2 How many client contacts were | CS-2 (on page 107)
made by each type of worker
from the service during the year?

OSR CS-3 How many individual clients CS-3 (on page 108)
were seen by your health service
during the period?
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Table 36. Summary of OSR reports (continued)

OSR report

Description

Further information

OSR CS-4

How many Adult Health
Checks and Chronic Disease
Management Plans were done
during the year?

CS-4 (on page 109)

OSR HP-1

How many health promotion
group activities were run during
the year?

HP-1 (on page 109)

OSR L-6

How many clients were seen by
the Link Up Service during the
year?

L-6 (on page 110)

OSR L-7

How many client contacts were
provided by the Link Up service
during the year?

L-7 (on page 110)

OSR MCH-1

How many Child Health Checks
were done during the year?

MCH-1 (on page 111)

OSR MCH-2

How many individual mothers
have attended routine antenatal
care during the year?

MCH-2 (on page 112)

OSR MCH-3

How many antenatal and
maternal group activities were
run during the year?

MCH-3 (on page 113)

OSR S-6

How many distinct individual
clients were seen by your
organisation during the year?

S-6 (on page 114)

OSR S-7a

How many distinct individual
clients received residential
treatment/rehabilitation at your
organisation during the year?

S-7a (on page 115)

OSR S-7b

What was the total length of
stay for each of your clients

in residential treatment /
rehabilitation during the year?

S-7b (on page 116)

OSR S-7c¢

How many residential
treatment/rehabilitation
episodes of care were provided
by your service during the year?

S-7c¢ (on page 116)
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Table 36. Summary of OSR reports (continued)

OSR report

Description

Further information

OSR S-10

How many distinct clients
attended your sobering-up
and/or residential respite/short
term care programs during the
year?

S-10 (on page 117)

OSR 5-11

How many 'sobering
up/residential
respite/short-term’ episodes
of care were provided by your
service during the year?

S-11 (on page 118)

OSR S-13

How many individual clients
received 'non-residential/follow
up / after care' from your
organisation during the year?

S-13 (on page 119)

OSR S-14

How many
'non-residential/follow up /
after care' episodes of care were
provided by your service during
the year?

S-14 (on page 120)

OSR SE-6

How many individual clients
were seen by SEWB Counsellors
during the year?

SE-6 (on page 121)

OSR SE-7

How many client contacts were
made by SEWB Counsellors
during the year?

SE-7 (on page 121)

OSR HCP

Health Care Provider (HCP)
report

Included in Communicare V18.1
and later HCP (on page 122)

OSR CS-1a - Episodes of care

Number of episodes of care provided within the previous 12 months.

Description

The report counts all services except:

« Anyno client contact service.

* The contact service of Admi ni strati on -

* Wi ti ng, Booked or Cancel | ed services.
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* Services provided by providers with a speciality of t ransport worker.
» Services recorded using the Tr ansport module.

« Services recorded for fictitious clients.

If there are multiple services recorded on the same day, only one is counted for this report.

Table 37. OSR CS-01

Element Description

Communicare reports
¢ Report > OSR > CS-01 Episodes of Health Care

Business rules Described above.

Additional data
recording considerations Note:

Currently there is no distinction between the encounter place
or contact types for multiple services recorded on the same
day.

OSR CS-2 - Client contacts
How many client contacts were made by each type of worker from the service during the year?
Description

The report counts all services except:

*Anyno client contact service.
« Wi ti ng, Booked or Cancel | ed services.

* Services recorded for fictitious clients.

Services recorded in the Transport Managenent module are also included where either the
pickup or the dropoff or both include an encounter place. If the transport service does not include

the encounter place, it is not counted.

Note:

The Transport Servi ces module is excluded.
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Table 38. OSR CS-02

Element

Description

Communicare reports

* Report > OSR > CS-02 Contacts by Worker Type

Business rules

For information about how Communicare speciality types are
mapped, see Client Contact Types reference (on page 49).

Additional data
recording considerations

A provider who is part of a service does not need to have recorded
any clinical information to be included. This means that a claiming
doctor who is added to a contact service for the purposes of making a
Medicare claim only is included in this report.

OSR CS-3a - Individual clients seen

How many Adult Health Checks and Chronic Disease Management Plans were done during the

year?

Description

The report counts all clients who had services except the following and services recorded for

fictitious clients.:

«Anyno client contact service.

* Wi ti ng, Booked or Cancel | ed services.

Table 39. OSR CS-03

Element

Description

Communicare reports

» Report > OSR > CS-04 Clinical Activities

Business rules

This report counts individuals who are included at least once in CS-2
(on page 107).

Additional data
recording considerations

none
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OSR CS-4 - Clinical Services CS-4 Record the count for the following
clinical activities carried out during the Financial Year

How many Adult Health Checks and Chronic Disease Management Plans were done during the

year?

Description

Health checks are identified either by Medicare claims for item 715 or alternatively by clinical
items with the system code of CHC (Child Health Check), AHC (Adult Health Check) and OHC (Older
person Health Check). If both a MBS 715 and an alternative health check are recorded for the

same patient, only the 715 check is counted.

Chronic disease management plans are identified either by Medicare claims for item 721 or
alternatively by clinical items with the system code of CPA. If both a MBS 721 and any clinical

items with system code CPA are recorded for the same patient, only the 721 plan is counted.

o ™
Note:
Because the claim and the evidence of the claim can be recorded on separate occasions,
and because items 715 and 721 are usually annual claims, individual patients rather than

individual claims or completed clinical items are reported .
- J

Table 40. OSR CS-04

Element Description

Communicare reports
* Report > OSR > CS-04 Clinical Activities

Business rules Evidence of claims for items 715 and 721 is searched for and if none
is found, the clinical items are searched using the system codes of
CHC, AHC, OHC and CPA.

Additional data none
recording considerations

OSR HP1 - Health Promotion HP-1 How many group activities and
population health promotional activities has your organisation run
during the Financial Year?

How many health promotion group activities were run during the year?
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Description

The report counts procedures with an export code starting HP- GRP, analysed by day and

encounter place in order to deduce the number of group sessions conducted, assuming that the

same type of session is not run repeatedly on the same day at the same place.

For detailed information about export codes, see Procedure, Immunisation, Pathology & Medicare

codes reference (on page 42).

Table 41. OSR HP-1

Element

Description

Communicare reports

* Report > OSR > HP-01 HP Group Activities

Business rules

All clinical items with appropriate codes recorded in any patient
record are deemed to be evidence of attendance at a group health
promotion event. Actual attendance is not counted so where a
non-patient record is used to record anonymous attendance, the
event is still recorded.

Additional data
recording considerations

No clinical items with these codes are distributed by Communicare
so all data collection for this indicator is done using locally defined
procedures.

OSR L-6 - Link Up L-6 How many individual clients were seen by
SEWB funded counsellors during the Financial Year?

How many clients were seen by the Link Up Service during the year?

Description

Link-up service contacts are identified by encounter place names which contain the words BTH or

Li nk Up or encounter program names which contain the words BTH, Li nk Up or Bri ngi ng

Them Hone.

Table 42. OSR L-6

Element

Description

Communicare reports

e Report > OSR > L-06 Individual Link Up Clients
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Table 42. OSR L-6 (continued)

Element Description

Business rules Any patient with at least one contact service recorded during the
report period at a BTH or Link Up encounter place or recorded with
the associated BTH or Link Up encounter program.

Additional data none
recording considerations

OSR L-7 - Link Up L-7 How many client contacts were provided by the
Link Up organisation during the Financial Year?

How many client contacts were provided by the Link Up service during the year?

Description

Link-up service contacts are identified by encounter place names which contain the words BTH or
Li nk Up or encounter program names which contain the words BTH, Li nk Up or Bri ngi ng
Them Hone.

Table 43. OSR L-7

Element Description

Communicare reports
* Report > OSR > L-07 Link Up Contacts

Business rules All contact services recorded during the report period at a BTH or
Link Up encounter place or recorded with the associated BTH or Link
Up encounter program.

Additional data none
recording considerations

OSR MCH-1 - Maternal and Child Health MCH-1 Record the number of
child health checks conducted in the Financial Year

How many Child Health Checks were done during the year?

Description

Health checks are identified by the client being 0 to 4 years of age and either a Medicare claimed
for item 715 or alternatively by clinical item with the system code of CHC. If both a MBS 715
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and an alternative health check (CHC) are recorded for the same patient, only the 715 check is

counted.

o M
Note:
Because the claim and the evidence of the claim can be recorded on separate occasions,
and because item 715 is usually an annual claim, individual patients are reported rather

than individual claims or completed clinical items. MBS item 10986 Healthy Kids Check

are identified by Medicare claims for item 10986.
- /

Table 44. OSR MCH-1

Element Description

Communicare reports
» Report > OSR > MCH-01 Child Health Checks

Business rules This report counts individuals with evidence of an annual child health
check during the report period. A patient with two such checks is
reported once only.

Additional data Medicare Item 10986 is no longer available.
recording considerations

OSR MC(CH-2 - Maternal and Child Health MCH-2 Record the number
of individual mothers who have attended a routine antenatal care
conducted by your organisation during the Financial Year

How many individual mothers have attended routine antenatal care during the year?

Description

Antenatal checks are identified by procedures with a PR- CHECK rule code; that is, all those items
listed on the Obstetrics tab, Antenatal Check.

Table 45. OSR MCH-2

Element Description

Communicare reports
* Report > OSR > MCH-02 Individual Antenatal Care Clients
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Table 45. OSR MCH-2 (continued)

Element

Description

Business rules

Any woman with an antenatal check performed during the report
period is included.

For details of how to record an antenatal check, see Procedure,
Immunisation, Pathology & Medicare codes reference (on page 42).

-~

Note:

If the response to the qualifier Ant enat al check

ignored. That is, if the response is At this encounter place
or there is no response, the check is counted.

per f or med is anything starting with El sewhere...the check is

Additional data
recording considerations

none

OSR MCH-3 - Maternal and Child Health MCH-3 Record whether
your organisation ran the following antenatal and maternal group
activities during the Financial Year

How many antenatal and maternal group activities were run during the year?

Description

Where possible, record the number of sessions run.

The report counts procedures with an export code starting MCH GRP, analysed by day and

encounter place in order to deduce the number of group sessions conducted, assuming that the

same type of session is not run repeatedly on the same day at the same place.

For details about export codes, see Procedure, Immunisation, Pathology & Medicare codes

reference (on page 42).

Table 46. OSR MCH-3

Element

Description

Communicare reports

* Report > OSR > MCH-03 MCH Group Activities
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Table 46. OSR MCH-3 (continued)

Element Description

Business rules All clinical items with appropriate codes recorded in any patient
record is deemed to be evidence of attendance at a maternal and
child health group health promotion event. Actual attendance is not
counted so where a non-patient record is used to record anonymous
attendance, the event is still recorded.

Additional data No clinical items with these codes are distributed by Communicare
recording considerations | so all data collection for this indicator is done using locally defined
procedures.

OSR S-6 - Standalone Substance Use S-6 How many distinct
individual clients were seen by your organisation during the Financial
Year?

How many distinct individual clients were seen by your organisation during the year?

Description

The report counts all clients who had services (except: no client contact’ services; 'waiting,
'booked’ or cancelled’ services) and services recorded for fictitious clients, who satisfy at least one

of the following criteria:

» Were receiving residential drug and alcohol care during part or all of the reporting period.

» Had received some 'sobering up/residential respite/short-term’ episodes of care during part
of the reporting period.

» Received a service associated with an encounter program containing the words '‘DRUG' and/
or ALCOHOL and/or AOD.

» Received a service associated with an encounter place containing the words 'DRUG" and/or
ALCOHOL and/or AOD.

* Received a service provided by a '‘Drug and alcohol counsellor' or a 'Substance misuse
worker’.

» Received a service having at least one procedure or referral that is not a recall or a
cancelled recall having a keyword containing the words 'DRUG' and/or ALCOHOL' and/or
AOD.
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Table 47. OSR S-6

Element Description

Communicare reports
* Report > OSR > S-06 Individual Clients

Business rules The description above details which services are counted as
substance use services.

Additional data This indicator was initially specified for standalone substance use
recording considerations | services only but has since been extended to mainstream health
services who receive funding for substance use support. As such

it is not yet clearly defined but the above conditions are fairly
comprehensive although they may over-report activity of this type.

OSR S-7a - Standalone Substance Use S-7a How many distinct
individual clients received residential treatment / rehabilitation at
your organisation during the Financial Year?

How many distinct individual clients received residential treatment/rehabilitation at your

organisation during the year?

Description

Residential treatment is identified by enrolments. Enrolments are identified by export code
DA- ENROL with a Treat ment del i very setti ng qualifier (DA- TDS export code) set to
Resi dential Treatment Facility.

Enrolments recorded for fictitious clients are not included.

Table 48. OSR S-7a

Element Description

Communicare reports
* Report > OSR > S-07 Individual Rehabilitation Clients

Business rules
The alcohol and other drug dataset distributed by Communicare

includes items with the appropriate codes to record the start and end
of periods of treatment.

For details about codes, see Procedure, Immunisation, Pathology &
Medicare codes reference (on page 42).
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Table 48. OSR S-7a (continued)

Element Description

Additional data The Communicare report numbering dates from an earlier numbering
recording considerations | system for OSR reporting — report 7 now reports for indicator 7a.

OSR S-7b - Standalone Substance Use S-7b What was the total length
of stay for each of your clients in residential treatment / rehabilitation
during the Financial Year?

What was the total length of stay for each of your clients in residential treatment / rehabilitation

during the year?
Description

Residential treatment is identified by enrolments. Enrolments are identified by export code
DA- ENROL with a Treat ment del i very setti ng qualifier (DA- TDS export code) set to
Resi dential Treatment Facility.

Enrolments recorded for fictitious clients are not included.

Table 49. OSR S-7b

Element Description

Communicare reports
» Report > OSR > S-07a Length of Stay

Business rules
The alcohol and other drug dataset distributed by Communicare

includes items with the appropriate codes to record the start and end
of periods of treatment.

For details about codes, see Procedure, Immunisation, Pathology &
Medicare codes reference (on page 42).

Additional data The Communicare report numbering dates from an earlier numbering
recording considerations | system for OSR reporting — report 7a now reports for indicator 7b.

OSR S-7c - Standalone Substance Use S-7c How many residential
treatment / rehabilitation episodes of care were provided by your
organisation during the Financial Year?

How many residential treatment/rehabilitation episodes of care were provided by your service

during the year?
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Description

Residential treatment is identified by enrolments. Enrolments are identified by export code
DA- ENROL with a Treat ment del i very setti ng qualifier (DA- TDS export code) set to

Resi dential Treatnment Facility.

Enrolments recorded for fictitious clients are not included.

Table 50. OSR S-7c

Element Description

Communicare reports
* Report > OSR > S-07b Residential Episodes

Business rules
The alcohol and other drug dataset distributed by Communicare

includes items with the appropriate codes to record the start and end
of periods of treatment.

For details about codes, see Procedure, Immunisation, Pathology &
Medicare codes reference (on page 42).

Additional data The Communicare report numbering dates from an earlier numbering
recording considerations | system for OSR reporting — report 7b now reports for indicator 7c.

OSR S-10 - Standalone Substance Use S-10 How many distinct clients
attended your sobering-up and/or residential respite/short term care
programs during the Financial Year?

How many distinct clients attended your sobering-up and/or residential respite/short term care

programs during the year?

Description

Sobering-up and/or Residential Respite/Short-term care episodes are identified by clinical items
with export codes of DR- ENROL and DA- SUCS.

Table 51. OSR S-10

Element Description

Communicare reports
* Report > OSR > S-10 Individual Non-Rehab Clients
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Table 51. OSR S-10 (continued)

Element Description

Business rules
The alcohol and other drug dataset distributed by Communicare

includes items with the appropriate codes to record the start and end
of periods of treatment.

For details about codes, see Procedure, Immunisation, Pathology &
Medicare codes reference (on page 42).

Additional data none
recording considerations

OSR S-11 - Standalone Substance Use S-11 How many ‘sobering up /
residential respite / short-term’ episodes of care were provided by
your organisation during the Financial Year?

How many 'sobering up/residential respite/short-term’ episodes of care were provided by your

service during the year?

Description

Sobering-up and/or Residential Respite/Short-term care episodes are identified by clinical items
with export codes of DR- ENROL and DA- SUCS.

Table 52. OSR S-11

Element Description

Communicare reports
» Report > OSR > S-11 Episodes Non-Rehab Clients

Business rules
The alcohol and other drug dataset distributed by Communicare

includes items with the appropriate codes to record the start and end
of periods of treatment.

For details about codes, see Procedure, Immunisation, Pathology &
Medicare codes reference (on page 42).

Additional data none
recording considerations
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OSR S-13 - Standalone Substance Use S-13 How many individual
clients received non-residential / follow up / after care’ from your
organisation during the Financial Year?

How many individual clients received 'non-residential/follow up / after care' from your

organisation during the year?

Description

The report counts all clients who had services (except: 'no client contact’ services; 'waiting,
'booked’ or cancelled’ services) and services recorded for fictitious clients, who satisfy at least one

of the following criteria:

* Received a service associated with an encounter program containing the words 'DRUG' and/
or ALCOHOL and/or AOD.

* Received a service associated with an encounter place containing the words 'DRUG' and/or
ALCOHOL and/or ‘AOD.

* Received a service provided by a 'Drug and alcohol counsellor’ or a 'Substance misuse
worker’,

* Received a service having at least one procedure or referral that is not a recall or a
cancelled recall having a keyword containing the words 'DRUG' and/or ALCOHOL' and/or
AOD.

Excluded are services where the client was receiving residential drug and alcohol care at that
time or attended a group session or was receiving 'sobering up/residential respite/short-term’ care

as a part of that service.

Table 53. OSR S-13

Element Description

Communicare reports
* Report > OSR > S-13 Individual Non-Residential Clients

Business rules The description above details which services are counted as
substance use services.

Additional data This indicator was initially specified for standalone substance use
recording considerations | services only but has since been extended to mainstream health
services who receive funding for substance use support. As such

it is not yet clearly defined but the above conditions are fairly
comprehensive although they may over-report activity of this type.
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OSR S-14 - Standalone Substance Use S-14 How many non-
residential / follow up / after care’ episodes of care were provided by
your organisation during the Financial Year?

How many 'non-residential/follow up / after care' episodes of care were provided by your service

during the year?

Description

The report counts all clients who had services (except: 'no client contact’ services; 'waiting,
'booked’ or cancelled’ services) and services recorded for fictitious clients, who satisfy at least one

of the following criteria:

* Received a service associated with an encounter program containing the words 'DRUG' and/
or ALCOHOL and/or ‘AOD.

* Received a service associated with an encounter place containing the words 'DRUG' and/or
ALCOHOL and/or ‘AOD.

* Received a service provided by a 'Drug and alcohol counsellor’ or a 'Substance misuse
worker’,

* Received a service having at least one procedure or referral that is not a recall or a
cancelled recall having a keyword containing the words 'DRUG' and/or ALCOHOL' and/or
AOD.

Excluded are services where the client was receiving residential drug and alcohol care at that
time or attended a group session or was receiving 'sobering up/residential respite/short-term’ care

as a part of that service.

Table 54. OSR S-14

Element Description

Communicare reports
* Report > OSR > S-14 Episodes of Non-Residential Care

Business rules The description above details which services are counted as
substance use services.

Additional data This indicator was initially specified for standalone substance use
recording considerations | services only but has since been extended to mainstream health
services who receive funding for substance use support. As such

it is not yet clearly defined but the above conditions are fairly
comprehensive although they may over-report activity of this type.
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OSR SE-6 - Social and Emotional Wellbeing SE-6 How many
individual clients were seen by SEWB funded counsellors during the
Financial Year?

How many individual clients were seen by SEWB Counsellors during the year?
Description

Table 55. OSR SE-6

Element Description

Communicare reports
 Report > OSR > SE-06 Individual SEWB Clients

Business rules For information about how Communicare speciality types are
mapped, see Client Contact Types reference (on page 49).

Patients with at least one service recorded in the report period with
any Communicare Speciality type that maps to an AIHW provider
type of Soci al and Enotional Well Being staff |
Counsel | or are counted once only.

Additional data none
recording considerations

OSR SE-7 - Social and Emotional Wellbeing SE-7 How many client
contacts were provided by the SEWB funded counsellors during the
Financial Year?

How many client contacts were made by SEWB Counsellors during the year?
Description

Table 56. OSR SE-7

Element Description

Communicare reports
» Report > OSR > SE-07 SEWB Contacts
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Table 56. OSR SE-7 (continued)

Element Description

Business rules For information about how Communicare speciality types are
mapped, see Client Contact Types reference (on page 49).

All services recorded in the report period with any Communicare
Speciality type that maps to an AIHW provider type of Soci al and
Enoti onal Well Being staff | Counsell or are counted.

Additional data none
recording considerations

OSR HCP Health Care Provider (HCP) report
Health Care Provider (HCP) report
Description

The Health Care Provider (HCP) report refers to the report submitted annually to the Department
of Health by all Australian Government funded Indigenous health services who are eligible to

claim Medicare benefits for primary health care services.

This report shows all providers that have a DOH Provider Number who were enabled for all or

part of the reporting period.

Table 57. OSR HCP

Element Description

Communicare reports
 Report > Health Care Providers > Provider List

Business rules All providers recorded in File > Provider who have at least one DOH
Provider number and who were not disabled before the start of the
report period nor only enabled after the end of the report period.

Additional data none
recording considerations

NSW KPlIs

Additional information for NSW KPIs.
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Before you start

Note:

Configuration notes are valid for the Version 5.0 of the NSW KPI reports.

If your health service is using Communicare ‘out of the box’ and has taken advantage of datasets

provided by Communicare, only the codes highlighted here need to be considered.

Note:

For best results when reporting, use the datasets provided by Communicare rather than

creating your own.

Clinical items

This section identifies any local clinical items that may be evidence of procedures and other

activity required for specific indicators.

Configuration is done at File > Reference Tables > Clinical Item Types.

Table 58. Required clinical items

Performance .
L For Description
indicator
Smoking Cessation
» Any procedure or referral which is
evidence of smoking cessation must use
the system code SCS
» Any procedure or referral performed which
is in the Tobacco use services
Immunisation Types | Influenza Communicare supports the Generic Influenza

AIR vaccine, with vaccine code GNFLU, and its
equivalents described in Equivalent and partial
equivalent vaccines table - GNFLU entry. For
example, GNFLU, PANVAX, FLUVAX, and so on.

Pertussis

The following export codes identify pertussis
vaccines: ADCL, ADPO, BOOST or BOIPV.

If you do not make Medicare claims, make sure that clinical items used to record care plans and

health checks use the following system codes.
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Qualifiers

This section identifies any local qualifiers that may be evidence of details required for specific

indicators.

Configuration is done at File > Reference Tables > Qualifier Types.

Table 59. Required qualifiers

Performance
L Code Description
indicator
Smoking Cessation |BI P Any clinical item that is evidence of ‘brief
intervention’ should have a qualifier that is either:
* A Yes/No qualifier with a system code of Bl P
A reference qualifier where relevant responses
have system codes of Bl P.
Smoking Status SMO or SMP

The central qualifiers are appropriately coded, but if
a local variation is used the qualifier itself must be a
reference qualifier with the system code SMO or SMP
(if recorded during a pregnancy).

Each reference must be coded in the following way:

» System Codes:
e S - current smoker
> E - ex-smoker
> N- never smoked
» For export code SMO:
> 1 - wants to quit now
> 2 - wants to quit later
> 3 - no intention of quitting
> 4 - quit less than 12 months ago
e 5 - quit 12 months or more ago
> 7 =non-smoker
» For export code S\VP:
o 1 - daily smoker
o 2 - weekly smoker
e 3 -irregular smoker
° 4 - quit during pregnancy
> 5 - quit before pregnancy
> 6 - non-smoker
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Table 59. Required qualifiers (continued)

Pe.rfo.rmance Code Description
indicator

Central pathology | BPS, CHO, CHR, Only of interest if the health service has local

qualifiers HDL, CVR- RO5C, equivalents:
CVR- RO5F, ACR,
GFE, HBA, HBM « Systolic blood pressure is determined as the
AUDI TC, XHB, XHC, latest qualifier with system code BPS
XCL, XGN, XSY,  Total cholesterol is determined as the latest

XHI

qualifier with system code CHOor CHR

« High density lipoprotein is determined as the
latest qualifier with system code HDL or CHR

e CVD risk assessment is determined as the
latest qualifier with export code CVR- RO5C

» (CARPA) or CVR- RO5F (Framingham).

e Urinary Albumin Creatinine Ratio is
determined as the latest qualifier with system
code ACR

 Estimated Glomerular Filtration Rate is
determined as the latest qualifier with system
code GFE.

e HbAlc is derived from numeric qualifiers with
a system code of HBA and units % or HBMand
units mmol/mol converted to percentage.

¢ AUDIT-C Score is determined by numeric
qualifiers with an export code of AUDI TC.

eHepatitis B result abnormal yes/no
qualifier (system code XHB). The qualifier
must be set to Yes to be counted.

e Hepatitis C result abnormal yes/no
qualifier (system code XHC). The qualifier
must be set to Yes to be counted.

e Chl anydi a result abnormal yes/no
qualifier (system code XCL). The qualifier
must be set to Yes to be counted.

e Gonorrhoea result abnormal yes/no
qualifier (system code XGN). The qualifier
must be set to Yes to be counted.

e Syphilis result abnornal yes/no
qualifier (system code XSY). The qualifier
must be set to Yes to be counted.

*H 'V result abnormal yes/no qualifier
(system code XHI ). The qualifier must be set
to Yes to be counted.
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Investigation Requests

This section identifies keywords that need to be attached to any of your investigation request

terms to identify them as STI test requests.
Configuration is done at File > Reference Tables > Investigations > Investigation Keywords.

STI request terms

Table 60. STI request terms

Infection keyword
Hepatitis B HepB
HBV DNA Viral load test HBV
HCV RNA test HVCRNA
Chlamydia CHLAMYDIA
Gonorrhoea GONORRHOEA
Syphilis SYPHILIS
HIV HIV

Liver Function Tests

Liver Function Tests are determined from Pathology test requests that have a keyword of LFT.

Central and imported codes

This section refers to codes that are attached to ICPC2-Plus items, MIMS medications, incoming
pathology results (LOINCs), and so on. Some labs use their own local codes to identify pathology

results and use of LOINCs for text-based results is not consistent.

Table 61. Central & imported codes

Database Report Description

MIMS Smoking Cessation Medications with an indication containing

the text smok or nicotine are identified as
smoking cessation treatments. For example,
the drug Champix is included because it has an
indication of Nicotine dependence.
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Table 61. Central & imported codes (continued)

Database Report

Description

CVD Risk Treatment

Medications with an indication of
hyperlipidaemia, hypercholesterolaemia

or hypertension are identified as smoking
cessation treatments. For example, the
drug Cleviprex is included because it has an
indication of Hypertension.

DAA Treatment

Recent prescriptions are identified by the
following generic components: pegylated
interferon, daclatasvir, sofosbuvir + ledipasvir,
ribavirin, sofosbuvir, paritaprevir + ritonavir +
ombitasvir + dasabuvir, paritaprevir + ritonavir +
ombitasvir + dasabuvir + ribavirin.

LOINC

Incoming pathology results are identified by
LOINGs (if supplied by the lab) for the specified
STI. For more information, see https://loinc.org/.
Additionally, if only positive results are
reported, the lab must return an abnormal code.

ICPC Diagnoses

Specific conditions for specific indicators are
identified in the NSW specifications document
Aboriginal Health Program Key Performance
Indicators: Data Specifications 2019/20-2021/22
Version 5.0 February 2021

NT AHKPIs

Additional information for NT AHKPI.

Before you start

Note:

For best results when reporting, use the datasets provided by Communicare rather than

creating your own.

Before you can effectively use the NT AHKPIs you need to configure parts of your database.

127


https://loinc.org/

Encounter place

Configure your encounter places:

1. Select File > Reference Tables > Encounter Place.
2. If you have only one clinic:
a. From the Locality Group list, select Heal th Service Area.
b. In the DHF Health Service Code field, enter the five digit code allocated by the
Department of Health and Families.

3. If you have multiple clinics, each encounter place must be allocated a unique locality
group that defines the localities covered by that encounter place. Ideally all localities
in the Health Service Area will be allocated to a single smaller locality group that will
be allocated to a single encounter place. Each encounter place must also be given the

appropriate DHF Health Service Code.

-
6 Tip:

To help you edit or create these groups, run the report Report > Reference Tables >

Locality Group Analysis. Enter a range of post codes that covers your Health Service

Area and the report will show you which localities belong to which locality group.
- /

Data requirements

Review the data collection requirements. Check the Healthy for Life (on page ) reports - many

of the indicators are comparable to those defined for Healthy for Life.

Further data collection requirements include:

» Anaemic children are identified by their latest qualifier Hb (Haemoglobin) recorded during
the reporting period being less than 110 g/L (less than 105 g/L if under 12 months old).

« Patients with albuminuria are defined as having a latest qualifier ACR (Alb/Creat Ratio)
recorded during the reporting period as being greater than 3.4.

« Patients are recognised as being on an ACE inhibitor, or ARB drug by checking their regular
and current medications as selected from the appropriate ATC (Anatomical Therapeutic
Chemical) codes.

* PAP smears are counted by looking for investigation requests for tests whose description
starts with PAP smear (case insensitive) or for clinical items with the export code
PAPSMEAR.

« If you do not make Medicare claims then you will need to make sure that clinical items

used to record care plans and health checks have the following system codes:
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unique_76
unique_76
unique_76

> GP management plan items must use CPA

o Team care arrangements must use TCA

o Adult health checks must use AHC

o Child health checks must use CHC

o Elderly health checks must use OHC

* Clients are assumed to be fully immunised if they have no overdue recalls for

immunisations (excluding Panvax and Fluvax) or immunisation reviews that were due
before the reference date or have an appropriate completed review. Immunisation
review items should start Revi ew; i mruni sati on; followed by the age, for example,

Revi ew; i mruni sati on; 2 nont hs age

Running the NT Aboriginal Health Key Performance Indicators (NT AHKPI) reports

Run the NT AHKPI reports from Report > NT KPI. Run each individual report to show data for each
KPI.

The data export file is created at Report > NT KPI > AHKPI Data Export.

A summary view of the data export file is available at Report > NT KPI > AHKPI Data Export

Summary.

Note:

Reports adhere to NT Aboriginal Health Key Performance Indicators, Definitions, October
2013, Version 2.0.4.

Because data is disaggregated by age, patients with no date of birth will not be included.
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Support
If you run into problems using Communicare, you can always get help from us.

For help and support, go the Communicare User Portal - Help and Support tab for general

information and further links.

If you still need help, create a support request with Telstra Health Support and we'll get back to

you.

Include as much information in the request as you can and follow these guidelines:

« If you include patient information, for patient confidentiality, use the Patient ID instead of
the patient’s name.

« If you include screenshots, ensure that you conceal both the patient’s name and date-of-
birth.

4 Fastpath:

For urgent problems or issues with using the portal, call 1800 798 441 to speak to a

support team member.

If reporting a problem, before contacting us, try to replicate the problem. It also helps to write

down the problem and the circumstances under which it occurred.

Release Notes

Release notes for all versions of Communicare are available on the Knowledge Centre.

To open the release notes for the latest version of Communicare:

1. On the Communicare User Portal > Help and Support https://communicare-
portal.telstrahealth.com/help-and-support/ tab, in the Knowledge Centre tile, click Learn
More.

2. In the Knowledge Centre https://communicare-portal.telstrahealth.com/knowledge/, from

the main menu, select Support > Release Notes > required release notes version.

0 Tip:

Release notes for the latest version are listed first.
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If you are using an older version of Communicare and want to refer to release notes for that
version, the release notes are included with the latest version. However, to display the complete
Knowledge Centre for your version of Communicare, in the Knowledge Centre, on the right side of

the main menu, select your version of Communicare.

Support PDFs oe

i ® vzl =

Cusreent (WI1.X

Va2

Quick links to release notes

V231
V224

* Older versions

Training

If you want someone to teach you how to use Communicare, from beginners to advanced users,

try our training.
We can organise someone to come to you, or you can access our eLearning.

o Tip:

Check our eLearning site regularly for our invaluable Tips and Tricks.

Request Remote Assistance

Run Teamviewer for quick support or request remote assistance.

Requesting Remote Assistance will allow Telstra Health Support to have a live view of your screen

so we can help you better.

To run remote assistance, when instructed by Telstra Health Support, in Communicare, select Help

> Request Remote Assistance.

In order to invoke Request Remote Assistance, on your keyboard, press CTRL+F2.
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Notices, acknowledgements and attributions

Notices

Words mentioned in this book that are known to be trademarks, whether registered or
unregistered, have been capitalised or use initial capitals. Terms identified as trademarks include

Microsoft®, Microsoft Windows®.

This software uses some third-party code (C) 2012 Arnaud Bouchez provided by Synopse - http://
synopse.info - under Mozilla Public License 1.1; modified source code is available at http://

SoftwareCompany.com/MPL.

Approval has been granted by the Tasmanian Government to use Communicare Version 22.1 as an

electronic prescription system in Tasmania.

If using the Australian Immunisation Register integration: Participating health professionals may
utilise the services and information provided including personal information only in accordance with
National (Privacy Act 1988, Health Insurance Act 1973, Australian Immunisation Register Act 2015 and

other relevant legislation), State or Territory legislation, Policy and Guidelines.

In Communicare V21.3 and later, to support Services Australia interactions, your patients' relevant
personal information is encrypted and sent from your Communicare server to Services Australia
web services via Communicare Next Generation. The data is retained by Communicare Next
Generation. Communicare Next Generation is hosted on Microsoft Azure cloud services, in highly
secure data centres based in Australia (Sydney, Canberra, Melbourne) which meet the Australian
Standards for Information Security. Microsoft has been awarded Certification for Protected data in
Australia. For more information about how Telstra Health manages personal information, see our

privacy policy.

In Communicare V22.1 and later, to support ePrescribing interactions, your patients' relevant
personal information is encrypted and sent from your Communicare server to an ETP service, such
as eRx, via Communicare Next Generation. The data is retained by Communicare Next Generation.
Communicare Next Generation is hosted on Microsoft Azure cloud services, in highly secure data
centres based in Australia (Sydney, Canberra, Melbourne) which meet the Australian Standards for
Information Security. Microsoft has been awarded Certification for Protected data in Australia. For

more information about how Telstra Health manages personal information, see our privacy policy.

In Communicare V22.1 and later, for printed PBS prescriptions, your patients’' relevant personal
information is encrypted and sent from your Communicare server to an ETP service, such as

eRx, via Communicare Next Generation. The data is retained by Communicare Next Generation.


http://synopse.info/
http://synopse.info/
http://softwarecompany.com/MPL
http://softwarecompany.com/MPL
https://www.telstrahealth.com/content/telstrahealth/en/privacy-policy.html
https://www.telstrahealth.com/content/telstrahealth/en/privacy-policy.html

Communicare Next Generation is hosted on Microsoft Azure cloud services, in highly secure data
centres based in Australia (Sydney, Canberra, Melbourne) which meet the Australian Standards for
Information Security. Microsoft has been awarded Certification for Protected data in Australia. For

more information about how Telstra Health manages personal information, see our privacy policy.

In Communicare V22.2 and later, for outgoing messages, your patients' relevant personal
information is encrypted and sent from your Communicare server to the recipient via
Communicare Next Generation (Secure Message Exchange). The data is retained by Communicare
Next Generation. Communicare Next Generation is hosted on Microsoft Azure cloud services,

in highly secure data centres based in Australia (Sydney, Canberra, Melbourne) which meet

the Australian Standards for Information Security. Microsoft has been awarded Certification for
Protected data in Australia. For more information about how Telstra Health manages personal

information, see our privacy policy.
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